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Most	FieldPoint	manuals	also	are	available	as	PDFs.	You	must	have	Adobe
Reader	with	Search	and	Accessibility	5.0.5	or	later	installed	to	view	the	PDFs.
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folder]\documentation\Manuals\Network	Modules\
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Conventions
This	help	file	uses	the	following	formatting	and	typographical	conventions:
<	> Angle	brackets	that	contain	numbers	separated	by	an	ellipsis	represent	a	range	of	values	associated

with	a	bit	or	signal	name—for	example,	AO	<0..3>.

[	] Square	brackets	enclose	optional	items—for	example,	[response].

» The	»	symbol	leads	you	through	nested	menu	items	and	dialog	box	options	to	a	final	action.	The
sequence	File»Page	Setup»Options	directs	you	to	pull	down	the	File	menu,	select	the	Page	Setup
item,	and	select	Options	from	the	last	dialog	box.

This	icon	denotes	a	note,	which	alerts	you	to	important	information.

This	icon	denotes	a	caution,	which	advises	you	of	precautions	to	take	to	avoid	injury,	data	loss,	or	a
system	crash.

bold Bold	text	denotes	items	that	you	must	select	or	click	in	the	software,	such	as	menu	items	and	dialog
box	options.	Bold	text	also	denotes	parameter	names.

dark	red Text	in	this	color	denotes	a	caution.

green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,	help	file,	or	Web	address.

italic Italic	text	denotes	variables,	emphasis,	cross	references,	or	an	introduction	to	a	key	concept.	Italic
text	also	denotes	text	that	is	a	placeholder	for	a	word	or	value	that	you	must	supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should	enter	from	the	keyboard,	sections	of	code,
programming	examples,	and	syntax	examples.	This	font	is	also	used	for	the	proper	names	of	disk
drives,	paths,	directories,	programs,	subprograms,	subroutines,	device	names,	functions,	operations,
variables,	filenames,	and	extensions.

monospace
bold

Bold	text	in	this	font	denotes	the	messages	and	responses	that	the	computer	automatically	prints	to
the	screen.	This	font	also	emphasizes	lines	of	code	that	are	different	from	the	other	examples.

monospace
italic

Italic	text	in	this	font	denotes	text	that	is	a	placeholder	for	a	word	or	value	that	you	must	supply.



Navigating	Help	(Windows	Only)
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to	the	left	of
this	window	or	use	the	following	toolbar	buttons	located	above	the	tabs:

Hide—Hides	the	navigation	pane	from	view.
Locate—Locates	the	currently	displayed	topic	in	the	Contents	tab,
allowing	you	to	view	related	topics.
Back—Displays	the	previously	viewed	topic.
Forward—Displays	the	topic	you	viewed	before	clicking	the	Back
button.
Options—Displays	a	list	of	commands	and	viewing	options	for	the	help
file.



Searching	Help	(Windows	Only)
Use	the	Search	tab	to	the	left	of	this	window	to	locate	content	in	this	help	file.	If
you	want	to	search	for	words	in	a	certain	order,	such	as	"related	documentation,"
add	quotation	marks	around	the	search	words	as	shown	in	the	example.
Searching	for	terms	on	the	Search	tab	allows	you	to	quickly	locate	specific
information	and	information	in	topics	that	are	not	included	on	the	Contents	tab.



Wildcards
You	also	can	search	using	asterisk	(*)	or	question	mark	(?)	wildcards.	Use	the
asterisk	wildcard	to	return	topics	that	contain	a	certain	string.	For	example,	a
search	for	"prog*"	lists	topics	that	contain	the	words	"program,"
"programmatically,"	"progress,"	and	so	on.
Use	the	question	mark	wildcard	as	a	substitute	for	a	single	character	in	a	search
term.	For	example,	"?ext"	lists	topics	that	contain	the	words	"next,"	"text,"	and
so	on.

Note		Wildcard	searching	will	not	work	on	Simplified	Chinese,	Traditional	Chinese,	Japanese,	and
Korean	systems.



Nested	Expressions
Use	nested	expressions	to	combine	searches	to	further	refine	a	search.	You	can
use	Boolean	expressions	and	wildcards	in	a	nested	expression.	For	example,
"example	AND	(program	OR	VI)"	lists	topics	that	contain	"example	program"	or
"example	VI."	You	cannot	nest	expressions	more	than	five	levels.



Boolean	Expressions
Click	the	 	button	to	add	Boolean	expressions	to	a	search.	The	following
Boolean	operators	are	available:

AND	(default)—Returns	topics	that	contain	both
search	terms.	You	do	not	need	to	specify	this
operator	unless	you	are	using	nested	expressions.
OR—Returns	topics	that	contain	either	the	first	or
second	term.
NOT—Returns	topics	that	contain	the	first	term
without	the	second	term.
NEAR—Returns	topics	that	contain	both	terms
within	eight	words	of	each	other.



Search	Options

Use	the	following	checkboxes	on	the	Search	tab	to	customize	a	search:
Search	previous	results—Narrows	the	results	from	a	search	that	returned
too	many	topics.	You	must	remove	the	checkmark	from	this	checkbox	to
search	all	topics.
Match	similar	words—Broadens	a	search	to	return	topics	that	contain
words	similar	to	the	search	terms.	For	example,	a	search	for	"program"
lists	topics	that	include	the	words	"programs,"	"programming,"	and	so	on.
Search	titles	only—Searches	only	in	the	titles	of	topics.



Printing	Help	File	Topics	(Windows	Only)
Complete	the	following	steps	to	print	an	entire	book	from	the	Contents	tab:

1.	 Right-click	the	book.
2.	 Select	Print	from	the	shortcut	menu	to	display	the	Print	Topics	dialog

box.
3.	 Select	the	Print	the	selected	heading	and	all	subtopics	option.

Note		Select	Print	the	selected	topic	if	you	want	to	print	the
single	topic	you	have	selected	in	the	Contents	tab.

4.	 Click	the	OK	button.



Printing	PDF	Documents
This	help	file	may	contain	links	to	PDF	documents.	To	print	PDF	documents,
click	the	print	button	located	on	the	Adobe	Acrobat	Viewer	toolbar.



Configuring	FieldPoint	in	MAX
With	NI	Measurement	&	Automation	Explorer	(MAX),	you	can	configure	a
FieldPoint	bank	manually	or	let	MAX	create	a	configuration	using	the	current
device	configuration	of	a	FieldPoint	system	on	your	network.	After	you	have
configured	the	devices	in	your	system,	you	can	read,	write,	and	test	FieldPoint
data	items	from	MAX.
MAX	makes	it	easy	to	ensure	the	integrity	of	your	FieldPoint	hardware
configuration	and	test	the	I/O	before	using	FieldPoint	from	other	software	such
as	LabVIEW,	Measurement	Studio,	LabWindows/CVI,	and	OPC.

1.	 Install	the	hardware	as	described	in	the	network	module	user	manual	or
quick	start	guide.

2.	 Launch	MAX.
3.	 Add	a	comm	resource	for	the	new	FieldPoint	bank	to	your	system.
4.	 Configure	communication	settings	for	the	new	serial	or	Ethernet	comm

resource.
5.	 Configure	access	control	if	the	network	module	is	an	Ethernet	module.
6.	 Configure	the	I/O	modules	and	individual	channels	on	the	bank.
7.	 Configure	the	bank	to	respond	in	specific	ways	to	system	failures	and

other	events.
8.	 Test	channels	and	data	items	by	reading	and	writing	to	them	on	the	I/O

Data	tab	in	MAX.
9.	 Save	the	configuration.	Select	the	FieldPoint	category	icon	under	My

System»Data	Neighborhood,	then	click	the	Save	button	on	the	toolbar.
Refer	to	the	Configuring	FieldPoint	in	LabVIEW	topic	of	the	FieldPoint
LabVIEW	Interface	Help	for	information	about	configuring	and	using	FieldPoint
in	LabVIEW	projects	and	applications.

FPMAXProvider.chm::/Adding_a_FieldPoint_Comm_Resource.html
FPMAXProvider.chm::/Configuring_Serial_Communication_Settings.html
FPMAXProvider.chm::/Configuring_Ethernet_Communication_Settings.html
FPMAXProvider.chm::/Configuring_Access_Control_for_FieldPoint_Ethernet_Controllers.html
FPMAXProvider.chm::/Configuring_Modules.html
FPMAXProvider.chm::/Configuring_Channels.html
FPMAXProvider.chm::/Configuring_a_FieldPoint_Bank.html
FPMAXProvider.chm::/Testing_Data_Items.html


The	MAX	Configuration	Tree
The	MAX	configuration	tree	is	the	leftmost	pane	of	the	MAX	window.	The	most
important	parts	of	the	tree	for	FieldPoint	are	My	System»Data	Neighborhood,
My	System»Devices	and	Interfaces,	and	Remote	Systems.
My	System»Data	Neighborhood	shows	everything	you	have	configured	for	use
on	your	system.	This	includes	FieldPoint	comm	resources,	devices,	and	data
items.
My	System»Devices	and	Interfaces	shows	installed	and	detected	hardware
connected	directly	to	the	host	PC,	such	as	a	FieldPoint	serial	bank	connected	to	a
COM	port.
Remote	Systems	shows	NI	hardware	on	your	network.	The	FP-1601	and	[c]FP-
20xx	FieldPoint	network	modules,	for	example,	appear	in	Remote	Systems
when	you	connect	them	to	your	network.



Installing	and	Upgrading	Software	on	FieldPoint	Ethernet
Controllers
The	version	of	the	RT	engine	on	a	[c]FP-2xxx	controller	must	match	the	version
of	the	LabVIEW	Real-Time	Module	installed	on	the	host	computer.	You	can	use
the	LabVIEW	Real-Time	Install	Software	Wizard	to	check,	install,	upgrade,	or
downgrade	software	on	a	[c]FP-2xxx	controller.	For	information	about	using	the
LabVIEW	Real-Time	Install	Software	Wizard,	refer	to	the	Installing	Software	on
a	LabVIEW	Real-Time	Target	topic	in	the	Remote	Systems	help	(Help»Help
Topics»Remote	Systems).	For	information	about	compatibility	between
LabVIEW	RT	and	FieldPoint	software	components	on	the	host	machine	and	on
the	FieldPoint	RT	controller,	refer	to	NI	Knowledge	Base	article	37F9DEXD.
To	upgrade	firmware	on	an	FP-160x	or	cFP-180x,	use	the	Firmware	tab	in	MAX.
Click	Browse,	then	browse	to	the	firmware	image,	select	it,	and	click	Upload.



Default	Installation	Directories
The	following	tables	list	the	default	installation	directories	for	components	of
FieldPoint.	Items	in	brackets	indicate	the	installation	directory	for	that	particular
program.	<Windows\System>	represents	your	Windows	system	directory,
typically	WINDOWS\System	or	WINNT\System32.



Firmware	Images	for	FieldPoint	Devices
Component Default	Directory	for	Installation

[c]FP-2xxx Refer	to	LabVIEW	Real-Time	module	documentation.

FP-1000 \Program	Files\National	Instruments\FieldPoint\Firmware\Serial

FP-1600 \Program	Files\National	Instruments\FieldPoint\Firmware\Ethernet\1600

FP-1601 \Program	Files\National	Instruments\FieldPoint\Firmware\Ethernet\1601

cFP-180x \Program	Files\National	Instruments\FieldPoint\Firmware\Ethernet\cFP-180x



LabVIEW	Interface
Component Default	Directory	for	Installation

FieldPoint	VIs <LabVIEW>\vi.lib\FieldPoint

FPLVMgr.dll <LabVIEW>\vi.lib\FieldPoint\SubVIs

Examples <LabVIEW>\Examples\FieldPoint

fplv.chm <LabVIEW>\help



CVI	Interface
Component Default	Directory	for	Installation

FieldPoint	Instrument
Driver

<CVI>\FieldPoint	&	<CVI>\Bin

Examples <CVI>\samples\FieldPoint

fpcvi.chm <CVI>\FieldPoint

FPCVIMgr.dll <Windows\System>

FieldPoint.h <CVI>\FieldPoint	&	<CVI>\include

FieldPoint.obj <CVI>\FieldPoint	&	<CVI>\Bin	&	<CVI>\extlib



OPC	Source
Component Default	Directory	for	Installation

FieldPointOPC2.exe Program	Files\National	Instruments\FieldPoint

opccomn_ps.dll <Windows\System>

opcproxy.dll <Windows\System>



Ethernet	Communication	Protocol	DLLs
Component Default	Directory	for	Installation

lkbrow.dll <Windows\System>

lkdynam.dll <Windows\System>

lkhist.dll <Windows\System>

lkobenv.dll <Windows\System>

lkproc.dll <Windows\System>

lkrealt.dll <Windows\System>

lksec.dll <Windows\System>

lksock.dll <Windows\System>

lkstime.dll <Windows\System>



Ethernet	Communication	Protocol	Services
Component Default	Directory	for	Installation

lkads.exe <Windows\System>

lkcitdl.exe <Windows\System>

lktsrv.exe <Windows\System>



Configuring	Comm	Resources
A	FieldPoint	comm	resource	is	a	pathway	through	which	MAX	communicates
with	FieldPoint	devices.	A	comm	resource	can	be	a	serial	port	or	an	IP	address.



Adding	a	FieldPoint	Comm	Resource	to	Your	System

Adding	a	FieldPoint	Serial	Comm	Resource
To	add	a	FieldPoint	serial	comm	resource	to	your	system,	complete	the
following	steps:

1.	 Install	the	serial	network	module	and	connect	it	to	the	host	PC	according
to	the	documentation	shipped	with	the	module.

2.	 Right-click	My	System»Devices	and	Interfaces	in	the	MAX
configuration	tree	and	select	Create	New.

3.	 In	the	Create	New	dialog	box	that	appears,	select	FieldPoint»FieldPoint
Serial,	then	click	Next.

4.	 Configure	serial	communication	settings	for	the	network	module.	When
you	click	Finish,	MAX	creates	a	serial	comm	resource	under	My
System»Devices	and	Interfaces	named	FP	@	COMx,	and	a	folder	for
the	new	serial	comm	resource	under	My	System»Data	Neighborhood.
If	you	have	the	Automatically	find	devices	checkbox	selected,	MAX
finds	all	devices	connected	to	the	serial	network	module	and	creates
default	items	for	them	under	the	new	serial	comm	resource.



Adding	a	New	FieldPoint	Ethernet	Comm	Resource
To	add	a	new	FieldPoint	Ethernet	comm	resource	to	your	system,	complete	the
following	steps:

1.	 Install	the	Ethernet	network	module	and	connect	it	to	the	network
according	to	the	documentation	shipped	with	the	module.

2.	 Expand	Remote	Systems	in	the	MAX	configuration	tree.
3.	 Click	IP	address	0.0.0.0,	then	click	the	Network	Settings	tab	at	the

bottom	of	the	pane	on	the	right.	If	there	is	more	than	one	0.0.0.0,	find	the
one	with	the	serial	number	of	the	network	module	you	installed.

4.	 Enter	the	network	settings	and	click	Apply.	Let	MAX	reboot	the
network	module	to	apply	the	new	settings.

5.	 Click	Find	Devices.	MAX	finds	all	devices	connected	to	the	remote
system	and	adds	default	items	for	them	in	My	System»Data
Neighborhood.



Adding	a	FieldPoint	Comm	Resource	that	Is	Already	on	the
Network
To	add	a	FieldPoint	comm	resource	to	your	system	when	the	comm	resource	is
already	on	the	network,	complete	the	following	steps:

1.	 Expand	Remote	Systems	in	the	MAX	configuration	tree.
2.	 Right-click	the	IP	address	of	the	remote	system	you	want	to	add	as	a

comm	resource	and	select	Find	Devices.	MAX	finds	all	devices
connected	to	the	remote	system	and	adds	default	items	for	them	in	My
System»Data	Neighborhood.



Configuring	Ethernet	Communication	Settings
If	you	are	using	a	[c]FP-20xx	with	the	LabVIEW	RT	module	version	7.0	or	later,
a	cFP-21xx,	or	a	cFP-180x,	and	your	network	has	a	DHCP	server,	you	can	select
Obtain	IP	address	from	DHCP	server	and	avoid	having	to	configure	IP	settings
for	the	controller.	You	cannot	configure	the	[c]FP-20xx	for	DHCP	while	it	is	in
safe	mode	if	the	safe	mode	version	is	10.4	or	earlier.
If	you	are	using	an	FP-160x,	or	your	network	does	not	have	a	DHCP	server,	or
you	want	to	assign	a	static	IP	address	to	the	FieldPoint	controller,	complete	the
following	steps:

1.	 On	the	Network	Settings	tab,	enter	a	name,	IP	address,	subnet	mask,
gateway,	and	DNS	server	address	for	the	Ethernet	network	module.
Click	Suggest	Values	or	ask	your	network	administrator	if	you	are
unsure	of	any	of	these	values.

2.	 Click	Apply.
Enter	an	IP	address	for	Time	Server	under	Additional	Configuration.
To	assign	an	IP	address	to	one	system	when	the	IP	is	currently	assigned	to
another	system,	complete	the	following	steps:

1.	 Delete	the	system	that	currently	has	the	IP	address	from	Remote
Systems.

2.	 Right-click	the	new	system	under	Remote	Systems	and	select	Change
IP	(Offline).

3.	 Enter	the	IP	address	in	the	dialog	box	that	appears,	then	click	OK.
Note		If	the	comm	resource	for	the	system	under	Data	Neighborhood	has	a	default	name	based	on	the	old
IP	address,	you	can	change	the	name	to	avoid	confusion.	However,	you	do	not	need	to	change	the	name.

For	more	information	about	Ethernet	communication	settings,	refer	to	the
Remote	Systems	help	(Help»Help	Topics»Remote	Systems).



Using	DHCP
DHCP	makes	it	easy	to	configure	and	test	the	FieldPoint	system	in	different
applications.	Static	IP	assignment	requires	more	user	involvement	in	initial
configuration	but	is	more	reliable.
If	a	FieldPoint	network	module	is	configured	to	use	DHCP	and	cannot	connect
to	the	DHCP	server	on	startup,	the	network	module	pauses	for	up	to	a	few
minutes	while	it	tries	to	connect	to	the	DHCP	server.	If	the	FieldPoint	system
can	become	disconnected	from	the	network,	assign	a	static	IP	address	to	the
network	module.
Depending	on	whether	Halt	if	TCP/IP	Fails	is	checked,	expect	the	following
behavior	from	LabVIEW	RT	7.0	or	later	and	a	LabVIEW	RT	controller	on
DHCP	failure	or	on	any	other	TCP/IP	failure:
Halt	if	TCP/IP	Fails	is	checked:	If	TCP/IP	fails	for	any	reason	on	system
startup,	LabVIEW	RT	restarts	the	controller	and	attempts	to	connect	again.	After
three	failed	attempts,	LabVIEW	RT	resets	the	controller	to	IP	address	0.0.0.0.
Halt	if	TCP/IP	Fails	is	unchecked:	LabVIEW	RT	starts	and	runs	applications	on
the	controller	at	system	startup,	even	if	TCP/IP	fails.	When	the	connection
becomes	available,	you	must	manually	restart	the	controller	in	order	to	connect	it
to	the	network.
Depending	on	whether	Halt	if	TCP/IP	Fails	is	checked,	expect	the	following
behavior	from	a	cFP-180x	on	DHCP	failure	or	on	any	other	TCP/IP	failure:
Halt	if	TCP/IP	Fails	is	checked:	If	TCP/IP	fails	for	any	reason	on	system
startup,	the	network	module	restarts	and	attempts	to	connect	again.	After	three
failed	attempts,	the	network	module	resets	its	IP	address	to	0.0.0.0	and	boots	into
safe	mode.
Halt	if	TCP/IP	Fails	is	unchecked:	The	network	module	starts	the	OptoMUX
server	on	the	RS-232	port	even	if	TCP/IP	fails.	When	the	connection	becomes
available,	you	must	manually	restart	the	controller	in	order	to	connect	it	to	the
Ethernet	network.



Configuring	Serial	Communication	Settings
1.	 Select	the	COM	port	that	the	serial	network	module	is	connected	to.
2.	 Specify	the	baud	rate	to	match	the	setting	on	the	network	module.
3.	 Specify	the	timeout.
4.	 Click	Finish	or	Apply.

If	the	Automatically	find	devices	box	is	checked	when	you	click	Apply,	MAX
queries	the	comm	resource	for	all	devices	connected	to	it	and	creates	default
items	for	them	in	My	System»Data	Neighborhood.



Configuring	Access	Control	for	FieldPoint	Ethernet	Network
Modules
You	can	limit	host	access	to	a	FieldPoint	Ethernet	network	module	by	setting
access	permissions	for	different	host	machines.	The	default	setting	gives	all	host
machines	Read/Write	access.	To	change	the	network	security	settings,	complete
the	following	steps:

1.	 Select	the	comm	resource	under	Remote	Systems	and	click	the
FieldPoint	Access	Control	tab.	If	the	host	machine	does	not	have	access
to	the	network	module,	the	Access	List	is	grayed	out.

2.	 Make	additions	or	changes	as	follows:
To	add	a	host	machine	to	the	list,	enter	its	IP	address	in	the	IP
Pattern	edit	box,	select	the	desired	access	type	(Read/Write,
Read	Only,	or	Deny	Access)	from	the	Access	Type	list,	then	click
the	Add	button.	You	can	use	the	*	wildcard	when	specifying	the
IP	address.	For	example,	to	give	Read/Write	access	to	all	hosts,
enter	*	in	the	IP	Pattern	edit	box,	or	to	Deny	Access	to	all
machines	on	the	111.222.333	subnet,	enter	111.222.333.*	in	the
IP	Pattern	box.
To	remove	a	host	machine	from	the	list,	either	click	the	entry	or
type	the	entry	in	the	IP	Pattern	box,	then	click	the	Remove
button	or	press	the	<Delete>	key.
If	you	have	an	IP	access	list	saved	in	a	file	or	you	want	the
security	settings	to	match	the	settings	of	another	network	module,
check	the	Import	box,	then	click	Browse	and	select	the	source.
The	settings	read	from	the	source	are	shown	in	the	Access	List,
and	you	can	modify	them	if	you	need	to.

Note		If	the	Access	List	is	not	empty,	any	IP	address	that	does	not	have	a	matching	entry	is	denied	access
to	the	network	module.

To	change	the	order	of	the	entries	in	the	list,	select	an	entry	and	click
the	up	arrow	or	down	arrow	button	that	is	located	next	to	the	Access
List.	A	new	entry	is	always	added	to	the	end	of	the	list.	You	can	have
multiple	matching	entries	for	a	given	IP	address.	In	that	case,	the	first
entry	that	matches	the	IP	address	is	used,	starting	from	the	bottom	of
the	list.
To	save	the	Access	List	to	a	file	to	be	used	for	other	network	modules,



click	the	Save	checkbox	and	enter	a	file	name.
Note		For	performance	reasons,	place	frequently	matched	entries	toward	the	bottom	of	the	Access	List.

3.	 When	you	are	satisfied	with	the	changes,	click	Apply.	A	dialog	box
prompts	you	for	the	password.	Enter	the	password	if	one	has	been	set	for
the	network	module,	then	click	OK	to	apply	the	changes	to	the	network
module.



Configuring	a	FieldPoint	Bank
On	the	Bank	Configuration	tab,	you	can	configure	watchdog	settings	for	the
bank,	configure	offline	devices,	reset	the	bank,	take	a	snapshot	of	the	current
bank	configuration,	and	restore	the	bank	to	factory	default	settings.



Configuring	the	Network	Watchdog
The	network	watchdog	enables	you	to	guard	your	system	against	failures	in	the
network	connection,	cables,	or	host	computer.	If	the	network	watchdog	is
enabled	and	the	network	module	loses	communication	with	all	hosts	or	clients
over	the	network,	the	network	module	sets	output	channels	to	predefined
watchdog	values.
By	default,	the	network	watchdog	for	a	FieldPoint	bank	is	disabled	on	power-up.
To	enable	the	network	watchdog	for	a	FieldPoint	bank,	complete	the	following
steps:

1.	 Select	the	bank	under	Devices	and	Interfaces	or	Remote	Systems.
2.	 In	the	Watchdog	Configuration	area	of	the	Bank	Configuration	tab,

select	Enable.
3.	 Enter	a	timeout	value	for	the	watchdog.	The	timeout	is	the	period	of	lost

communication	with	hosts	or	clients	over	the	network	before	the
watchdog	settings	take	effect.	The	maximum	value	is	65536	ms.

Note		Make	sure	the	factory	configuration	box	is	unchecked
before	you	click	Apply.

4.	 Click	Apply.
5.	 Click	Save.

The	network	watchdog	is	now	enabled	for	this	FieldPoint	bank.	If	you	want
individual	output	channels	to	revert	to	predefined	output	values	in	case	of
communication	failure,	you	also	must	complete	the	following	steps:

1.	 Under	Devices	and	Interfaces	or	Remote	Systems,	select	the	device	that
contains	the	output	channels	you	want	the	watchdog	to	affect.

2.	 Click	the	Device	Configuration	tab.
3.	 In	the	Watchdog	Configuration	area,	select	Enable.
4.	 Click	Apply.
5.	 Click	the	Channel	Configuration	tab.
6.	 Select	the	output	channel	you	want	the	watchdog	to	affect.
7.	 Enter	a	Watchdog	Value	and	click	Enable.
8.	 Repeat	steps	6	and	7	for	each	channel	you	want	the	watchdog	to	affect.
9.	 Click	Apply.
Caution		The	network	watchdog	is	not	compatible	with	embedded	applications	on	a	LabVIEW	RT



controller	such	as	the	[c]FP-2xxx.	National	Instruments	recommends	that	you	use	the	hardware	watchdog
functionality	available	in	LabVIEW	RT.	Refer	to	the	user	manual	for	the	controller	for	more	information
about	the	hardware	watchdog.



Copying	a	Configuration	to	One	or	More	FieldPoint	Banks
You	can	use	the	Copy	Bank	Wizard	to	copy	the	configuration	on	an	existing
FieldPoint	bank	to	one	or	more	other	FieldPoint	banks,	reproducing	all	custom
data	items,	ranges,	startup	states,	and	other	settings	that	you	have	configured	for
the	I/O	modules	on	the	bank.	The	Copy	Bank	Wizard	copies	some	network
module	configuration	but	does	not	copy	data	items	on	the	network	module.
The	Copy	Bank	Wizard	creates	comm	resources	in	the	.iak	file	for	the	copied
banks.	In	addition	to	modifying	the	.iak	file,	the	Copy	Bank	Wizard	can	apply
the	copied	configuration	to	one	or	more	of	the	target	banks	if	the	banks	are
online.
Complete	the	following	steps	to	copy	the	configuration	of	a	FieldPoint	bank	to
one	or	more	other	FieldPoint	banks.

1.	 From	My	System»Data	Neighborhood,	right-click	the	comm	resource
for	the	bank	you	want	to	copy	and	select	Go	to	Comm	Resource
Configuration.	From	Devices	and	Interfaces	or	Remote	Systems,	select
the	comm	resource	for	the	bank	you	want	to	copy.

2.	 Click	the	+	sign	beside	the	comm	resource	so	that	the	bank	icon	appears.
3.	 Right-click	the	bank	icon	and	select	Copy	Bank.
4.	 Enter	the	number	of	banks	to	which	you	want	to	copy	the	configuration,

then	click	Next.
5.	 Enter	the	properties	for	the	first	system	in	the	dialog	box	that	appears.	If

the	bank	is	offline	or	if	for	any	other	reason	you	want	to	store	the
configuration	to	apply	to	the	bank	later,	uncheck	Apply	copied
configuration	to	hardware.

6.	 Click	Next	to	move	on	to	the	next	bank.
7.	 When	you	have	finished	setting	the	properties	for	all	the	banks,	click

Finish.



Tips	for	Copying	to	Ethernet	Banks
If	the	bank	has	an	IP	address	and	is	connected	to	the	network,	you	can
select	the	IP	address	from	the	Use	Existing	Bank	Address	drop-down
control.	The	Copy	Bank	Wizard	populates	the	Network	Module	Type	and
IP	Address	/	Host	Name	controls.
Alternatively,	you	can	enter	the	host	name	in	the	IP	Address	/	Host
Name	control.	Type	the	host	name	as	it	appears	under	Remote	Systems,
and	use	the	Network	Module	Type	drop-down	control	to	select	the	correct
type.
If	the	IP	Address	/	Host	Name	matches	that	of	a	comm	resource	in	the
.iak	file,	the	Copy	Bank	Wizard	uses	that	name	for	the	comm	resource	of
the	target	bank.	Otherwise,	if	you	do	not	enter	a	name	for	the	comm
resource,	the	Copy	Bank	Wizard	uses	the	default	naming	convention	for
the	target	bank.



Tips	for	Copying	to	Serial	Banks
If	the	COM	port	matches	that	of	a	comm	resource	in	the	.iak	file,	the
Copy	Bank	Wizard	uses	that	name	for	the	comm	resource	of	the	target
bank.	Otherwise,	if	you	do	not	enter	a	name	for	the	comm	resource,	the
Copy	Bank	Wizard	uses	the	default	naming	convention	for	the	target
bank.
Refer	to	the	FP-1000/1001	User	Manual	or	the	FP-1000/1001	Quick
Start	Guide	for	information	about	determining	the	address	of	a	serial
network	module.



Network	Module	Configuration
If	the	network	modules	on	the	configured	bank	and	on	the	target	bank	are
of	the	same	type,	the	Copy	Bank	Wizard	copies	all	of	the	network	module
settings	to	the	target	bank.	If	the	network	modules	are	of	different	types,
the	Wizard	copies	only	compatible	settings.	The	Wizard	does	not	copy
data	items	from	one	network	module	to	another	regardless	of	type.	Check
the	network	module	configurations	on	copied	banks	to	make	sure	that	the
settings	are	correct.



Using	the	Snapshot	Feature
The	Snapshot	feature	provides	you	with	a	single-step	method	for	saving	all	of
the	current	settings	(ranges,	attributes	and	current	output	data	values)	as	the
power-up	state	for	the	bank.

Caution		Using	the	Snapshot	feature	overwrites	any	power-up	values	you	have	specified	for	individual
channels	using	the	configurable	power-up	method.

Caution		Make	sure	the	factory	configuration	checkbox	is	unchecked	when	you	are	using	the	Snapshot
feature.

To	use	the	Snapshot	feature,	follow	these	steps:
1.	 Bring	all	channels	to	the	desired	power-up	settings,	including	ranges,

attributes,	and	output	values.	Using	the	Snapshot	saves	the	current
network	watchdog	data	values.	It	does	not	save	any	other	network
watchdog	settings.

2.	 Select	the	bank	in	the	Configuration	tree.
3.	 Click	the	Snapshot	button.	Click	Yes	and	Apply	to	approve	the	change.
4.	 Select	Tools»FieldPoint»Save	or	click	the	Save	button.

You	may	want	to	change	the	stored	Snapshot	information	later.	To	make
incremental	changes	to	the	Snapshot	information,	use	the	configurable	power-up
method.



Configuring	Devices
On	the	Device	Configuration	tab,	you	can	see	and	change	the	type,	address,	and
retry	count	of	a	FieldPoint	I/O	module,	and	you	can	enable	or	disable	watchdog
settings.	To	see	and	change	settings	for	individual	channels,	select	the	Channel
Configuration	tab.



Adding	a	Device
Complete	the	following	steps	to	add	a	device	to	a	previously	created	comm
resource.

1.	 Right-click	the	bank	and	select	Create	New	Device.
2.	 Select	the	Device	Type	you	want	to	configure.
3.	 Enter	the	correct	address	of	the	device	in	the	FieldPoint	bank.	(The

default	address	may	not	be	the	correct	address.)
4.	 If	the	device	is	a	serial	network	module,	make	sure	the	Address	DIP

settings	in	the	Device	Configuration	dialog	box	match	those	on	the
network	module.

5.	 Set	any	watchdog	timeout	and	power-up	configurations.
6.	 Click	OK.



Deleting	a	Device
To	delete	a	FieldPoint	device,	right-click	the	device	in	the	configuration	tree	and
select	Delete.
Deleting	the	device	removes	all	item	configuration	for	the	device	in	Data
Neighborhood	and	all	hardware	configuration	for	the	device	in	Devices	and
Interfaces	or	Remote	Systems.



Replacing	a	Network	Module	with	a	Network	Module	of	a
Different	Type
To	replace	a	network	module	on	a	FieldPoint	bank	and	keep	the	same
configuration	for	all	of	the	I/O	modules	on	the	bank,	complete	the	following
steps:

1.	 Turn	off	the	power	to	the	bank	and	disconnect	the	power	supply	from	the
network	module.

2.	 Remove	the	network	module	from	the	bank.
3.	 Install	the	new	network	module	as	described	in	the	quick	start	guide

shipped	with	the	module.
4.	 Connect	the	power	supply	to	the	new	network	module	as	described	in

the	quick	start	guide.
5.	 Connect	the	new	network	module	to	the	computer	or	the	network.
6.	 Power	up	the	network	module.
7.	 Find	the	comm	resource	for	the	configured	bank	under	My

System»Devices	and	Interfaces,	right-click	it,	and	select	Go	to	Comm
Resource	Configuration.

8.	 Click	the	+	sign	beside	the	comm	resource	so	that	the	bank	icon	appears,
right-click	the	bank	icon,	and	select	Copy	Bank.

9.	 Click	Next.
10.	 Select	the	comm	resource	type	for	the	new	network	module.	Select

Ethernet	for	an	Ethernet	network	module	or	RS232/485	for	a	serial
network	module.



Configuring	I/O	Modules
To	configure	an	I/O	module,	select	the	module	under	Devices	and	Interfaces	or
Remote	Systems.	A	window	appears	with	the	following	tabs:
Device	Configuration
Channel	Configuration



Configuring	Channels
On	the	Channel	Configuration	tab,	you	can	configure	ranges,	watchdog	values,
power-up	settings,	deadband,	attributes,	and	commands	for	each	channel	of	a
FieldPoint	module.



Deadbanding	for	Ethernet	Modules
Ethernet	network	modules	with	appropriate	firmware	(minimum	revision	0300
for	an	FP-1600,	any	revision	for	a	[c]FP-2xxx,	cFP-180x,	or	FP-1601)	can	apply
deadbands	to	the	analog	and	count	input	channels	of	connected	I/O	modules.
The	deadband	is	a	filter	that	enables	you	to	specify	the	percentage	change
required	in	order	for	a	signal	to	be	transmitted	to	any	clients.	For	example,
consider	an	analog	input	channel	with	a	range	of	0-10	V	and	a	1%	deadband.
This	channel	transmits	new	values	back	to	clients	only	when	the	voltage	has
changed	more	than	0.1	V.	Signal	changes	less	than	0.1	V	are	ignored,	allowing
you	to	filter	out	noise	and	reduce	the	use	of	network	bandwidth.
Follow	these	steps	to	configure	a	deadband:

1.	 Select	the	I/O	module	under	Devices	and	Interfaces	or	Remote	Systems.
2.	 Click	the	Channel	Configuration	tab.
3.	 Select	an	analog	or	count	input	channel.
4.	 Under	Data	Configuration,	enter	a	value	for	Percent	Deadband.
5.	 Click	Apply.



Configuring	Power-Up	States
Unless	you	configure	FieldPoint	modules	to	save	their	states,	a	power	cycle	or	a
reset	to	the	bank	will	cause	output	channels	to	return	to	their	factory	default
output	states.	To	avoid	this	problem,	you	can	configure	a	preferred	power-up
state	for	your	hardware.
To	configure	a	power-up	state	for	your	hardware,	you	can	use	the	Snapshot
feature	or	the	configurable	power-up	method.	With	the	Snapshot	feature,	you
bring	the	hardware	into	the	desired	state	and	take	a	"snapshot"	of	that	state.	The
configurable	power-up	method	is	not	as	fast	as	the	Snapshot	method,	but	it
allows	you	to	specify	power-up	values	without	having	to	bring	the	hardware	into
the	desired	state.



Using	the	Configurable	Power-Up	Settings	Method
When	you	want	to	configure	a	power-up	state	for	your	hardware,	you	can	use	the
Snapshot	feature	or	the	configurable	power-up	method.	To	use	the	configurable
power-up	method,	follow	these	steps:

1.	 Select	the	module	under	Devices	and	Interfaces	or	Remote	Systems	and
click	the	Channel	Configuration	tab.

2.	 Fill	in	power-up	output	values	for	the	channels	you	want	to	configure.
3.	 Click	Apply.	

When	you	click	Apply,	the	attributes,	ranges,	deadband,	and	network
watchdog	values	are	sent	to	the	devices	to	be	used	as	the	current	settings
and	power-up	settings.	Power-up	attributes	and	ranges	are	always	the
same	as	the	current	attributes	and	ranges.	The	power-up	output	values
are	sent	to	the	device	to	be	used	whenever	a	reset	or	power	cycle	occurs.

4.	 Select	the	bank	for	the	device.
Note		Make	sure	the	factory	configuration	box	is	unchecked
before	you	click	Apply.

5.	 On	the	Bank	Configuration	tab,	click	Apply.
6.	 Click	Save.



Configuring	Items
An	item	represents	one	or	more	physical	channels	on	a	FieldPoint	device.

Note		If	a	FieldPoint	item	represents	more	than	one	analog	or	count	channel,	you	can	read	from	and	write
to	only	the	first	channel	of	the	item	from	MAX.



Adding	an	Item
1.	 Right-click	a	device	under	Data	Neighborhood	and	select	Create	New

Item.
2.	 If	you	are	using	a	LabVIEW	RT	controller	such	as	the	[c]FP-2xxx,	select

I/O	Item	or	LabVIEW	Item.



Deleting	an	Item
Right-click	an	item	under	Data	Neighborhood	and	select	Delete.



Duplicating	an	Item
1.	 Right-click	an	item	under	Data	Neighborhood	and	select	Duplicate.
2.	 Specify	the	number	of	duplicate	items	to	create.
3.	 Click	OK.



Editing	an	Item
1.	 Select	an	item	under	Data	Neighborhood	and	click	the	Item

Configuration	tab.
2.	 Enter	the	parameters	in	the	dialog	box	that	appears.
3.	 Click	Apply.



Item	Configuration	Tab
On	the	Item	Configuration	tab,	you	can	rename	an	item,	select	the	advise	rate
and	type,	and	select	channels	to	include.



Creating	a	New	I/O	Item
To	create	a	new	FieldPoint	item	using	one	or	more	channels,	right-click	a	device
under	My	System»Data	Neighborhood	and	select	Create	New	Item...	In	the
Create	New	I/O	Item	dialog	box	that	appears,	you	can	rename	the	new	item,
select	the	advise	rate	and	type,	and	select	channels	to	include.



Testing	FieldPoint	Items
Use	the	I/O	Data	tab	to	read	from	and	write	to	FieldPoint	data	items	in	MAX.



Reading	Items
1.	 Select	the	device	containing	the	item(s)	in	My	System»Data

Neighborhood.
2.	 Click	the	I/O	Data	tab.
3.	 To	read	all	items	on	the	device,	click	Start.	To	read	one	or	more	items,

select	the	items,	then	click	Start.



Writing	to	Items
1.	 Select	the	device	containing	the	item(s)	in	My	System»Data

Neighborhood.
2.	 Click	the	I/O	Data	tab.
3.	 Select	the	item,	then	click	Write.
4.	 Enter	a	value	to	write	to	the	item.
5.	 Click	Write.



Changing	the	Screen	Update	Rate
By	default,	MAX	updates	the	list	view	once	every	250	milliseconds	(ms).	You
can	change	the	MAX	screen	update	rate	from	the	I/O	Data	tab	by	selecting
Tools»FieldPoint»I/O	Data»Set	Screen	Update	Rate,	and	entering	a	new	rate.
Use	a	faster	screen	update	rate	if	you	are	reading	FieldPoint	items	that	change	at
rates	faster	than	once	every	250	ms.



Using	FieldPoint	I/O	from	LabVIEW
Complete	the	following	steps	to	use	FieldPoint	I/O	from	within	LabVIEW.

1.	 Configure	and	test	your	FieldPoint	system	in	MAX.
2.	 Go	to	Tools»FieldPoint»Save	to	save	the	.iak	configuration	file.
3.	 Exit	MAX.
4.	 Launch	LabVIEW.
5.	 Use	the	FieldPoint	I/O	control	and	FieldPoint	VIs	to	construct	your

LabVIEW	FieldPoint	application.
The	LabVIEW	FieldPoint	VIs	access	FieldPoint	data	items	through	their	items,
device,	and	communication	resource	names.	Refer	to	the	FieldPoint	LabVIEW
Interface	Help	and	the	LabVIEW	FieldPoint	example	VIs	for	more	information
about	using	FieldPoint	I/O	from	LabVIEW.



Using	FieldPoint	I/O	from	LabWindows/CVI
Complete	the	following	steps	to	use	FieldPoint	I/O	from	LabWindows/CVI.

1.	 Configure	and	test	the	FieldPoint	system	in	MAX.
2.	 Go	to	Tools»FieldPoint»Save	to	save	the	.iak	configuration	file.
3.	 Exit	MAX.
4.	 Launch	LabWindows/CVI.
5.	 Use	the	CVI-FieldPoint	function	panels	to	construct	your

LabWindows/CVI	FieldPoint	application.
The	LabWindows/CVI	FieldPoint	functions	access	the	FieldPoint	data	items
through	their	item,	device,	and	communication	resource	names	as	configured	in
your	.iak	configuration	file.	Refer	to	the	LabWindows/CVI	FieldPoint
instrument	driver	help,	the	FieldPoint	LabWindows/CVI	Interface	Help,	and	CVI
FieldPoint	examples	for	more	information	on	FieldPoint	I/O	from
LabWindows/CVI.



FieldPoint	Error	and	Warning	Codes
The	following	table	lists	error	and	warning	codes	that	FieldPoint	can	return	from
procedure	calls.	Error	codes	have	a	negative	value	and	warning	codes	have	a
positive	value.	Errors	and	warnings	between	33486	and	33792	(absolute	value)
are	specific	to	the	FieldPoint	module	type.	Refer	to	the	FieldPoint	I/O	Module
Quick	Reference	for	descriptions	of	module-specific	error	codes	if	they	are	not
listed	in	this	help	file.
To	convert	from	FieldPoint	server	error	code	to	FieldPoint	module	error	code,
use	the	following	formulas:
If	the	FieldPoint	server	error	code	is	between	33486	and	33586,	inclusive:
Module	Error	Code	=	FieldPoint	Error	Code	–	33486
If	the	FieldPoint	server	error	code	is	greater	than	33586,	the	return	code
indicates	that	some,	but	not	all,	of	the	channels	associated	with	a	FieldPoint	item
have	a	module	error	code:
Module	Error	Code	=	FieldPoint	Error	Code	–	33586
Error	or
Warning
Code

Meaning	of	Error	or	Warning

–34244 Unable	to	delete	a	nonexistent	or	empty	object.

–34238 Incomplete	object	state.	Some	of	the	information	in	a	configuration	file	is	not	in	the	proper	format.	The
necessary	data	to	create	a	comm	resource,	device,	or	item	either	was	not	present	or	could	not	be
interpreted.	The	configuration	file	may	be	corrupt.

–34220 The	current	configuration	file	is	read-only.	You	can	view	and	use	the	file	but	cannot	save	any	changes
to	it.

–34219 Failed	to	open/read	the	configuration	file.	Verify	that	the	specified	path	name	is	correct	and	that	you
have	access	privileges	to	the	file.

–34218 Error	closing	a	file.	Possible	cause:	The	file	was	not	opened	successfully	or	it	has	already	been	closed.

–34217 Error	creating	the	configuration	file.	Possible	cause:	Another	file	with	the	same	name	already	exists	or
the	system	is	out	of	disk	space	or	you	do	not	have	privileges	to	create	a	file.

–34216 Error	opening	a	configuration	file.	Possible	cause:	The	file	does	not	exist	or	you	do	not	have	access	to
it.

–34215 The	internal	state	of	the	object	is	invalid.	The	object	is	either	not	properly	initialized	or	has	been
corrupted.

–34214 Failed	to	create	module	information	file	for	an	FP-TB-10	module.	The	required	dual-channel	module
information	is	either	nonexistent	or	corrupt.

–34211 Error	creating	Windows	registry	key.	Possible	cause:	The	key	already	exists	or	the	user	does	not	have
access	to	modify	the	registry.

–34210 Error	opening	Windows	registry.	Possible	cause:	The	key	does	not	exist	or	the	user	does	not	have
access	to	the	registry	with	the	ACCESS	parameters	specified	by	the	open	call.
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–34209 Could	not	write	to	Windows	registry	key.	Possible	cause:	The	key	is	opened	in	read-only	mode	or	the
user	does	not	have	access	to	modify	the	registry.

–34208 Failed	to	read	Windows	registry.	Possible	causes:	The	required	key	does	not	exist	or	the	user	does	not
have	read	access	to	the	registry.

–34201 Memory	allocation	has	failed.	Possible	cause:	The	system	is	out	of	memory.	Close	some	other
applications	to	free	memory.

–34117 Attempt	to	publish	data	of	incorrect	type	for	specified	item.	The	value	wired	into	the	input	value
terminal	of	the	FP	Publish	Data	VI	does	not	match	the	data	type	of	the	existing	item.

–34116 Desired	value	is	outside	the	configured	range	for	some	channels.

–34115 The	tag	handle	passed	to	a	FieldPoint	VI	is	invalid	or	unknown.

–34114 Invalid	IO	Control	string.	The	string	value	of	the	FieldPoint	IO	Control	Node	could	not	be	parsed	into
constituent	configuration	file	path	name,	comm	resource,	device,	and	item.

–34112 The	specified	.iak	file	path	is	not	valid	for	the	configuration	alias	provided.	The	server	name	must
match	the	alias	assigned	to	the	provided	configuration	file	path.

–34110 The	requested	new	configuration	file	short	name	is	already	associated	with	a	different	configuration
path.

–34109 The	database	that	associates	short	names	with	configuration	paths	is	unavailable.	Most	likely	the	file
could	not	be	opened.	Make	sure	you	have	read	privileges	for	the	directory	where	FieldPoint	is
installed.

–34108 The	specified	name	is	not	associated	with	a	configuration	file	path.	The	requested	action	cannot	be
taken	using	the	name	provided.

–34107 Unable	to	load	the	FieldPoint	server	.dll.	Possible	cause:	The	.dll	does	not	support	the	required
interface.

–34106 The	registered	path	for	the	FieldPoint	server	is	invalid.	Make	sure	the	FieldPoint	software	is	properly
installed	and	registered.

–34104 A	required	.dll	failed	to	load	properly.	The	.dll	path	may	be	invalid	or	the	dll	may	not	exist	on	this
machine.

–34103 Invalid	parameter.	At	least	one	of	the	parameters	passed	to	this	function/VI	has	an	invalid	or
unsupported	value.

–34102 Invalid	Custom	Create	Tag	VI.	Custom	Create	Tag	VIs	must	be	in	the	vi.lib\FieldPoint\Custom	Create
Tag	directory.

–34101 Desired	value	is	outside	the	configured	range.

–33818 The	desired	IP	address	is	already	in	use	by	a	different	FieldPoint	network	module.

–33817 Unable	to	use	the	COM	port.	Another	comm	resource	in	this	configuration	is	already	using	this	COM
port.

–33816 Unexpected	character	received	from	Optomux	response.

–33812 Unable	to	use	the	COM	port.	The	COM	port	is	already	in	use	by	a	different	FieldPoint	communication
resource	with	different	baud	rate	settings.

–33811 Unable	to	bind	to	the	COM	port.	Another	application	is	already	using	the	COM	port.

–33810 The	message	from	the	serial	port	has	a	checksum	different	from	the	one	calculated	by	the	host
application.

–33809 The	specified	COM	port	does	not	exist	on	your	machine.	Check	your	system	devices	to	make	sure	your
COM	port(s)	is	present	and	has	required	system	resources



–33808 The	desired	baudrate	is	not	supported	by	the	underlying	network	bus.

–33807 The	IP	address	is	invalid.	The	given	IP	address	does	not	follow	the	IP	address	syntax	required	by	the
Ethernet	protocol.

–33806 The	required	network	connection	was	not	found.	Possible	cause:	A	network	resource	specified	in	a
Create	Tag	call	was	not	available	when	the	tag	was	created.

–33805 The	server	received	an	invalid	termination	character	from	Serial	communication.

–33804 Ethernet	communication	has	failed.	Possible	cause:	missing	or	disconnected	network	card	or	network
card	drivers.

–33803 The	channel	has	not	yet	been	subscribed	to.

–33802 The	host	has	read-only	access	to	this	device.

–33801 The	host	does	not	have	access	to	this	device.

–33192 Deadbanding	is	not	supported	for	the	selected	channel.	Deadbanding	is	supported	only	for	analog	input
and	count	input	channels	on	FieldPoint	Ethernet	banks.	Older	versions	of	the	FP-1600	firmware	(older
than	3.0)	also	do	not	support	deadbanding.

–33191 The	desired	range	is	not	supported	by	this	I/O	module.	Refer	to	the	I/O	module	documentation	for	a
list	of	supported	ranges	and	corresponding	range	IDs.

–33190 The	IP	pattern	used	to	configure	FieldPoint	Access	Control	is	not	valid.	Valid	combinations	are:	*,
[num].*,	[num].[num].*,	[num].[num].[num].*	(where	[num]	can	be	any	integer	from	0-255).

–33189 A	module	of	different	type	already	exists	at	the	specified	address	in	the	currently	loaded	configuration.

–33186 Invalid	attribute	value.	The	specified	attribute(s)	does	not	support	the	desired	attribute	setting.	Check
the	operating	instructions	to	make	sure	this	setting	is	valid	for	the	I/O	module	you	are	using.

–33185 Invalid	channel	attribute.	The	specified	attribute	is	not	supported	by	the	addressed	channel(s).

–33184 Invalid	deadband	value.

–33183 Unable	to	create	an	I/O	item	for	this	device.	The	device	does	not	support	I/O	items..

–33181 Invalid	password.	The	password	provided	to	change	network	security	settings	is	invalid	or	incorrect.

–33180 The	amount	of	data	provided	does	not	match	the	number	of	data	items	required	or	the	number	of
channels	to	be	addressed.

–33165 The	item	addressed	does	not	exist.	Possible	cause:	The	device	is	not	connected	or	the	item	address	is
invalid.

–33160 The	requested	feature	is	not	supported	by	this	type	of	network	or	I/O	module.

–33159 The	firmware	on	the	network	module	does	not	support	the	requested	feature.	Upgrade	the	firmware	to
the	latest	released	version	(download	from	ni.com\support\fieldpoint)	and	try	again.

–33157 The	I/O	module	at	this	address	has	been	hotswapped	by	a	module	of	an	incompatible	type.	Replace
with	a	module	of	the	original	type	for	proper	operation.

–33156 The	device	is	offline.	Make	sure	the	device	is	connected	and	its	power	is	on.

–33155 Module	information	not	available	for	any	FieldPoint	module.	You	may	have	accidentally	deleted	the
module	information	files	or	corrupted	your	registry.	Rerun	the	FieldPoint	installer	to	repair	your
FieldPoint	installation.

–33154 The	module	addressed	is	not	of	the	selected	type.

–33153 Error	identifying	module.	Possible	causes:	(1)	The	module	information	is	not	available	on	your	system,
or	(2)	the	module	is	returning	an	invalid	module	ID.	For	(1),	the	module	may	be	newly	released	and	it
must	be	online	for	the	software	to	configure	it	the	first	time,	OR	you	may	have	accidentally	deleted	the
module	information	file(s)	and/or	corrupted	your	registry.	Rerun	the	FieldPoint	installer	to	repair	your



FieldPoint	installation.	For	(2),	module	may	not	be	correctly	plugged	in	or	the	EEPROM	on	the
module	may	be	corrupted.

–33036 Unknown	error.	An	unidentifiable	error	condition	has	occurred.

–33035 Hardware	error	on	instrument.	An	irrecoverable	fault	has	occurred.

–33034 The	response	to	the	last	command	is	unavailable.

–33033 The	module	addressed	by	the	"Resend	Last	Response"	is	not	the	same	module	that	was	addressed	by
the	previous	command.

–33032 The	module	has	been	hotswapped	since	it	was	last	sent	a	command.	This	response	is	sent	only	if	the
network	module	is	enabled	to	report	hotswaps,	and	if	the	hotswap	occurred	after	hotswap	reporting
mode	was	enabled.	The	command	was	ignored.	This	error	number	can	be	sent	in	response	to	a	standard
command	if	you	have	enabled	hotswap	reporting	for	the	bank.

–33030 One	or	more	attributes	specified	either	do	not	exist	or	do	not	support	the	setting	specified.	The
command	was	ignored.

–33029 One	or	more	ranges	specified	in	the	command	either	do	not	exist	or	do	not	support	the	setting
specified.	The	command	was	ignored.

–33028 One	or	more	channels	specified	in	the	command	either	do	not	exist	or	do	not	support	the	operation
specified.	The	command	was	ignored.

–33027 The	module	addressed	does	not	exist.

–33026 The	FieldPoint	network	module	detected	a	serial	framing	error	in	the	command.	The	command	was
ignored.

–33025 The	command	is	valid	but	is	not	supported	by	the	addressed	module.

–33024 One	or	more	characters	sent	in	the	command	could	not	be	correctly	converted	to	a	digit	(hex	or
decimal).

–32903 The	specified	limits	are	invalid	for	the	command.	This	includes	notification	that	an	invalid	digit	(hex	or
decimal)	was	received.

–32902 Communications	link	network	watchdog	timed	out.	The	command	was	ignored.

–32901 Not	enough	characters	received.	The	module	received	an	insufficient	or	incorrect	number	of	characters
for	the	specified	command.

–32900 An	unprintable	ASCII	character	was	received	by	the	module.	Only	characters	from	ASCII	value	33	to
127	are	permitted	within	commands.	The	command	was	ignored.

–32899 Input	buffer	overrun.	The	received	command	was	too	long.	The	command	was	ignored.

–32898 The	checksum	does	not	match	the	sum	of	command	characters.	The	checksum	in	the	command	does
not	match	the	calculated	checksum	of	the	characters	in	the	command.	The	command	was	ignored.

–32897 Undefined	or	invalid	command.	The	command	character	was	not	a	legal	command	character,	or	the
addressed	module	does	not	support	this	command.	The	command	was	ignored.

–32896 Power-up	clear	expected.	The	FieldPoint	bank	has	power	cycled	since	the	last	communication	was
sent.	The	command	was	ignored.

–32834 An	advise	operation	on	the	selected	item	has	already	been	started.	You	must	stop	the	current	operation
before	starting	a	new	one.

–32831 The	selected	comm	resource	has	no	network	or	I/O	modules	associated	with	it.	Make	sure	the
FieldPoint	bank	is	online	and	you	have	access	to	the	network	module.	An	empty	Ethernet	comm
resource,	if	saved,	can	create	an	invalid	.iak	file.

–32824 The	specified	item	name	is	already	defined.

–32823 The	specified	device	name	is	already	defined.



–32822 The	specified	comm	resource	name	is	already	defined.

–32819 The	specified	item	is	not	present	in	the	currently	loaded	configuration	file.

–32817 The	specified	device	is	not	present	in	the	currently	loaded	configuration	file.

–32816 The	specified	comm	resource	is	not	present	in	the	currently	loaded	configuration	file.

–32811 The	FieldPoint	server	failed	either	to	destroy	some	of	its	active	objects	or	to	terminate	some	service(s).

–32810 The	FieldPoint	server	initialization	failed.	Possible	causes:	1.	Missing	or	corrupt	configuration	file;	2.
Failed	to	create	callbacks.

–32809 The	FieldPoint	server	has	already	been	initialized.

–32808 The	FieldPoint	server	has	not	been	initialized.

–32806 Tag	name	too	long.	Possible	cause:	Tag	name	exceeds	the	character	limit	(31	characters)	set	by	the
configuration	file.

–32805 The	tag	name	contains	illegal	characters.	Possible	cause:	The	name	of	a	channel,	block,	device,	or
comm	resource	includes	a	line	feed	or	a	carriage	return.

–32802 An	invalid	completion	was	specified.

0 Success

32768 The	task	is	terminated.	Most	likely	the	FP	Close	was	called	before	this	task	was	finished.

32769 The	task	is	pending.

32803 An	invalid	task	ID	was	specified.	The	task	ID	used	when	calling	FP_ReadCache	or	FP_Stop	is	invalid.
Verify	that	the	task	ID	used	matches	the	task	ID	returned	by	FP_Advise.

32804 An	invalid	IAHandle	was	specified.	Verify	that	the	configuration	file	is	valid	and	the	IAHandle	used
matches	the	IAHandle	returned	by	FP_Open.

32812 The	specified	tag	name	was	not	found.

32816 The	specified	comm	resource	is	not	present	in	the	currently	loaded	configuration	file.

32817 The	specified	device	is	not	present	in	the	currently	loaded	configuration	file.

32819 The	specified	item	is	not	present	in	the	currently	loaded	configuration	file.

32820 The	item	is	read	only.

32821 The	item	is	write	only.

32822 The	specified	comm	resource	name	is	already	defined.

32823 The	specified	device	name	is	already	defined.

32824 The	specified	item	name	is	already	defined.

32826 Failed	to	create	or	initialize	at	least	one	of	the	objects	in	the	configuration	file.	Your	next	save	will	save
only	the	objects	that	were	successfully	created.

32828 The	connection	to	a	remote	device	timed	out.

32832 Initialization	of	default	channel	name	database	failed.	Any	new	item	created	by	"Find	Devices"	will	be
named	"Channel."	Make	sure	your	FieldPoint	software	is	installed	and	registered	properly.

32896 Power-up	clear	expected.	The	FieldPoint	bank	has	power	cycled	since	the	last	communication	was
sent.	The	command	was	ignored.

32897 Undefined	or	invalid	command.	The	command	character	was	not	a	legal	command	character,	or	the
addressed	module	does	not	support	this	command.	The	command	was	ignored.

32898 The	checksum	does	not	match	the	sum	of	command	characters.	The	checksum	in	the	command	does



not	match	the	calculated	checksum	of	the	characters	in	the	command.	The	command	was	ignored.

32899 Input	buffer	overrun.	The	received	command	was	too	long.	The	command	was	ignored.

32900 An	unprintable	ASCII	character	was	received	by	the	module.	Only	characters	from	ASCII	value	33	to
127	are	permitted	within	commands.	The	command	was	ignored.

32901 Not	enough	characters	received.	The	module	received	an	insufficient	or	incorrect	number	of	characters
for	the	specified	command.

32902 Communications	link	network	watchdog	timed	out.	The	command	was	ignored.

32903 The	specified	limits	are	invalid	for	the	command.	This	includes	notification	that	an	invalid	digit	(hex	or
decimal)	was	received.

33024 One	or	more	characters	sent	in	the	command	could	not	be	correctly	converted	to	a	digit	(hex	or
decimal).

33025 The	command	is	valid	but	is	not	supported	by	the	addressed	module.

33026 The	FieldPoint	network	module	detected	a	serial	framing	error	in	the	command.	The	command	was
ignored.

33027 The	module	addressed	does	not	exist.

33028 One	or	more	channels	specified	in	the	command	either	do	not	exist	or	do	not	support	the	operation
specified.	The	command	was	ignored.

33029 One	or	more	ranges	specified	in	the	command	either	do	not	exist	or	do	not	support	the	setting
specified.	The	command	was	ignored.

33030 One	or	more	attributes	specified	either	do	not	exist	or	do	not	support	the	setting	specified.	The
command	was	ignored.

33032 The	module	has	been	hotswapped	since	it	was	last	sent	a	command.	This	response	is	sent	only	if	the
network	module	is	enabled	to	report	hotswaps,	and	if	the	hotswap	occurred	after	hotswap	reporting
mode	was	enabled.	The	command	was	ignored.	This	error	number	can	be	sent	in	response	to	a	standard
command	if	you	have	enabled	hotswap	reporting	for	the	bank.

33033 The	module	addressed	by	the	"Resend	Last	Response"	is	not	the	same	module	that	was	addressed	by
the	previous	command.

33034 The	response	to	the	last	command	is	unavailable.

33035 Hardware	error	on	instrument.	An	irrecoverable	fault	has	occurred.

33036 Unknown	error.	An	unidentifiable	error	condition	has	occurred.

33153 Error	identifying	module.	Possible	causes:	(1)	The	module	information	is	not	available	on	your	system,
or	(2)	the	module	is	returning	an	invalid	module	ID.	For	(1),	the	module	may	be	newly	released	and	it
must	be	online	for	the	software	to	configure	it	the	first	time,	OR	you	may	have	accidentally	deleted	the
module	information	file(s)	and/or	corrupted	your	registry.	Rerun	the	FieldPoint	installer	to	repair	your
FieldPoint	installation.	For	(2),	module	may	not	be	correctly	plugged	in	or	the	EEPROM	on	the
module	may	be	corrupted.

33154 The	module	addressed	is	not	of	the	selected	type.

33156 The	device	is	offline.	Make	sure	the	device	is	connected	and	its	power	is	on.

33157 The	I/O	module	at	this	address	has	been	hotswapped	by	a	module	of	an	incompatible	type.	Replace
with	a	module	of	the	original	type	for	proper	operation.

33158 The	I/O	module	at	this	address	has	been	hotswapped	by	a	different	module	of	compatible	type.	No
action	necessary.

33161 The	write	operation	failed	to	change	the	value	on	the	FieldPoint	bank.	The	connection	may	be	broken.

33162 Unable	to	connect	to	the	data	item	on	the	module.	Possible	causes:	(1)	A	connection	is	broken,	or	(2)



the	network	module	is	not	powered	on.

33163 The	connection	to	the	module	has	been	broken.	Check	cabling,	power,	etc.

33183 The	desired	configuration	value	was	out	of	range.	It	has	been	coerced	to	the	nearest	valid	number.

33185 Invalid	channel	attribute.	The	specified	attribute	is	not	supported	by	the	addressed	channel(s).

33186 Invalid	attribute	value.	The	specified	attribute(s)	does	not	support	the	desired	attribute	setting.	Check
the	operating	instructions	to	make	sure	this	setting	is	valid	for	the	I/O	module	you	are	using.

33191 The	desired	range	is	not	supported	by	this	I/O	module.	Refer	to	the	I/O	module	documentation	for	a
list	of	supported	ranges	and	corresponding	range	IDs.

33436 Bad	channel	status	reported	by	module.	The	module	is	in	one	of	the	following	states:	Unconfigured,
Bad	Status	"A",	Bad	Status	"B".

33437 The	specified	serial	network	module	was	sent	a	Power-Up	Clear	command.

33438 Bad	channel	status	"A"	reported	for	all	contained	channels.	A	channel-specific	error	has	occurred.
Check	module	documentation	for	more	details.

33439 Bad	channel	status	"B"	reported	for	all	contained	channels.	A	channel-specific	error	has	occurred.
Check	module	documentation	for	more	details.

33440 Bad	channel	status	"Unconfigured"	reported	for	all	contained	channels.	All	channels	are	in	the
"unconfigured"	state.	This	error	can	occur	if	the	network	module	is	unable	to	configure	the	module
because	of	a	hardware	failure.

33441 None	of	the	contained	channels	exists.

33442 An	unknown	warning	was	returned	by	the	optomux-based	serial	hardware.	Possible	cause:	recoverable
fault.

33443 Bad	channel	status	reported	by	several	channels.	At	least	one	channel	is	in	one	of	the	following	states:
Unconfigured,	Bad	Status	"A",	Bad	Status	"B"

33445 Bad	channel	status	"B"	reported	for	several	contained	channels.	A	channel-specific	error	has	occurred.
Check	module	documentation	for	more	details.

33446 Bad	channel	status	"Unconfigured"	reported	for	several	contained	channels.	Some	channels	are	in
"unconfigured"	state.	This	error	can	occur	if	the	network	module	is	unable	to	configure	a	module
because	of	a	hardware	failure.

33447 Several	contained	channels	do	not	exist.

33448 Bad	channel	status	reported	for	all	contained	channels.	All	channels	are	in	one	of	the	following	states:
Unconfigured,	Bad	Status	"A",	Bad	Status	"B".

33487 Out	of	range.	The	input	signal	you	are	measuring	has	gone	out	of	the	specified	measurement	range.
Check	the	signal	and,	if	necessary,	change	the	range	the	channel	is	using.

33488 Open	current	loop.	Check	wire	connections	for	possible	breakage	or	disconnection.

33489 Open	thermocouple.	The	thermocouple	module	did	not	detect	a	thermocouple	connection	on	the
channel.	Check	connections	for	possible	breakage	or	disconnection.

33490 Open	RTD	detected.	The	RTD	module	did	not	detected	an	RTD	on	the	channel.	Check	connections	for
possible	breakage	or	disconnection.

33491 Count	overflowed	since	last	read.	The	counter	module	has	reached	its	maximum	count	value.	No
action	required.

33492 The	channel	is	sourcing	the	maximum	current	allowed.	The	device	attached	to	the	channel	is	drawing
the	maximum	current	from	the	channel.	Check	for	possible	shorts	or	external	device	failure.

33493 The	channel	is	in	overcurrent	protection	mode.	The	device	attached	to	the	channel	is	passing	more
current	than	is	allowed	through	the	channel.	Check	for	possible	shorts	or	external	device	failure.



33494 Empty	base	or	slot.	The	specified	module	cannot	be	detected	by	the	network	module	or	the	FP-TB-10
base.	Make	sure	the	module	is	firmly	fitted	into	the	base	and	that	the	POWER	and	READY	LEDs	are
lit.

33495 Bad	data	from	channel.	The	data	is	corrupted	and	cannot	be	displayed	correctly.

33496 The	channel	exceeded	the	specified	terminal	count.

33587 Some	channels	out	of	range.	More	than	one	of	the	input	signals	that	you	are	measuring	has	gone	out	of
the	specified	measurement	range.	Check	the	signals	and,	if	necessary,	change	the	range	the	module	is
using.

33588 Open	current	loop	on	some	channels.	One	or	more	channels	of	the	module	has	detected	an	open	current
loop.	Check	wire	connections	for	possible	breakage	or	disconnection.

33589 Open	thermocouple	on	some	channels.	More	than	one	channel	on	the	thermocouple	module	has	failed
to	detect	a	thermocouple	connection.	Check	connections	for	possible	breakage	or	disconnection.

33590 Open	RTD	on	some	channels.	More	than	one	channel	on	the	RTD	module	has	failed	to	detect	an	RTD.
Check	connections	for	possible	breakage	or	disconnection.

33591 Count	overflowed	since	last	read	for	some	channels.	Some	channels	on	the	counter	module	have
reached	their	maximum	count	value.	No	action	required.

33592 More	than	one	channel	is	sourcing	the	maximum	current	allowed.	The	device	attached	to	the	channel	is
drawing	the	maximum	current	from	the	channel.	Check	for	possible	shorts	or	external	device	failure.

33593 Some	channels	are	in	overcurrent	protection	mode.	The	device	attached	to	the	channel	is	passing	more
current	than	is	allowed	through	the	channel.	Check	for	possible	shorts	or	external	device	failure.

33594 Empty	base	or	slot.	The	specified	module	cannot	be	detected	by	the	network	module	or	the	FP-TB-10
base.	Make	sure	the	module	is	firmly	fitted	into	the	base	and	that	the	POWER	and	READY	LEDs	are
lit.

33595 Bad	data	from	channel(s).	The	data	is	corrupted	and	cannot	be	displayed	correctly.

33818 The	desired	IP	address	is	already	in	use	by	a	different	FieldPoint	comm	resource.

34206 An	invalid	status	code	was	specified.	The	status	code	received	does	not	match	the	predefined	list	of
error	codes	returned	by	the	FieldPoint	software.

34208 Failed	to	read	Windows	registry.	Possible	causes:	The	required	key	does	not	exist	or	the	user	does	not
have	read	access	to	the	registry.

34212 Error	closing	Windows	registry.	Possible	cause:	The	key	does	not	exist	or	has	not	been	opened.

34213 Error	accessing	module	information.	The	corresponding	file	either	cannot	be	found	or	cannot	be
opened.

34218 Error	closing	a	file.	Possible	cause:	The	file	was	not	opened	successfully	or	it	has	already	been	closed.

34220 The	current	configuration	file	is	read-only.	You	can	view	and	use	the	file	but	cannot	save	any	changes
to	it.

34238 Incomplete	object	state.	Some	of	the	information	in	a	configuration	file	is	not	in	the	proper	format.	The
necessary	data	to	create	a	comm	resource,	device,	or	item	either	was	not	present	or	could	not	be
interpreted.	The	file	configuration	may	be	corrupt.



Using	FieldPoint	I/O	from	an	OPC	Client
Complete	the	following	steps	to	use	FieldPoint	I/O	from	an	OPC	client.

1.	 Configure	and	test	your	FieldPoint	system	in	MAX.
2.	 Go	to	Tools»FieldPoint»Save	to	save	the	.iak	configuration	file.
3.	 Exit	MAX.
4.	 Launch	the	OPC	client.
5.	 Select	NationalInstruments.OPCFieldPoint.
6.	 Follow	the	instructions	given	by	the	OPC	client	to	monitor	FieldPoint

I/O
.

The	FieldPoint	OPC	Server	imports	the	information	from	the	last	saved	.iak	file
in	order	to	access	FieldPoint	data	items.

Note		You	can	use	any	OPC	client,	including	the	OPC	client	shipped	with	National	Instruments
LabVIEW,	LabVIEW	DSC,	and	Lookout	software.



[c]FP-AI-100
All	ID	values	are	hexadecimal.



Module	ID
010A



Channel	Status
Message ID

Out	of	range 01



Ranges
Name ID

024	mA 00

3.524	mA 01

±24	mA 02

±6	V 05

06	V 06

±1.2	V 07

01.2	V 08

018	V 0E

±36	V 0F

036	V 11

±18	V 12



No	Attributes

No	Commands



[c]FP-AI-102
All	ID	values	are	hexadecimal.



Module	ID
0115



Channel	Status
Message ID

Out	of	range 01



Ranges
Name ID
020	V 13

±20	V 14

060	V 15

±60	V 16

0120	V 17

±120	V 18



No	Attributes

No	Commands



[c]FP-AI-110
All	ID	values	are	hexadecimal.



Module	ID
0101



Channel	Status
Message ID

Out	of	range 01



Ranges
Name ID

021	mA 00

3.521	mA 01

±21	mA 02

±10.4	V 03

010.4	V 04

±5.2	V 05

05.2	V 06

±1.04	V 07

01.04	V 08

±325	mV 09

±65	mV 0A



Attributes
Name ID Value ID

Noise	Rejection 01 60	Hz 00

50	Hz 01

500	Hz 02



No	Commands



[c]FP-AI-111
All	ID	values	are	hexadecimal.



Module	ID
010C



Channel	Status
Message ID

Out	of	range 01



Ranges
Name ID

021	mA 00

3.521	mA 01

±21	mA 02



Attributes
Name ID Value ID

Noise	Rejection 01 60	Hz 00

50	Hz 01

500	Hz 02



No	Commands



cFP-AI-118
All	ID	values	are	hexadecimal.



Module	ID
0127



Channel	Status
Message ID

Out	of	range 01



Ranges
Name ID
±10.4	V 03

010.4	V 04

±5.2	V 05

05.2	V 06

±1.04	V 07

01.04	V 08

018	V 0E

±18	V 12



Attributes
Name ID Value ID

Noise	Rejection 01 10	Hz 0B

None FE



No	Commands



FP-AI-C020
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID
020	mA 00



Attributes
Name ID Value ID

Input	Filter 01 20	Hz 07

100	Hz 06



No	Commands



FP-AI-C420
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID
420	mA 01



Attributes
Name ID Value ID

Input	Filter 01 20	Hz 07

100	Hz 06



No	Commands



[c]FP-AIO-600
All	ID	values	are	hexadecimal.



Module	ID
0123



Channel	Status
Message ID

Overcurrent	protection	(inputs) 01

Open	current	loop	(outputs) 02



Ranges
Type Name ID

Input 024	mA 00

3.524	mA 01

±24	mA 02

±12	V 03

012	V 04

±6	V 05

06	V 06

018	V 0E

±36	V 0F

036	V 11

±18	V 12

Output 021	mA 00

3.521	mA 01



No	Attributes

No	Commands



[c]FP-AIO-610
All	ID	values	are	hexadecimal.



Module	ID
011B



Channel	Status
Message ID

Overcurrent	protection	(inputs) 01

Overcurrent	protection	(outputs) 07



Ranges
Type Name ID

Input 024	mA 00

3.524	mA 01

±24	mA 02

±12	V 03

012	V 04

±6	V 05

06	V 06

018	V 0E

±36	V 0F

036	V 11

±18	V 12

Output ±12	V 03

012	V 04



No	Attributes

No	Commands



FP-AI-V1
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID
01	V 08



Attributes
Name ID Value ID

Input	Filter 01 20	Hz 07

2	kHz 05



No	Commands



FP-AI-V5
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID
05	V 06



Attributes
Name ID Value ID

Input	Filter 01 20	Hz 07

2	kHz 05



No	Commands



FP-AI-V5B
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID
±5	V 05



Attributes
Name ID Value ID

Input	Filter 01 20	Hz 07

2	kHz 05



No	Commands



FP-AI-V10
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID
010	V 04



Attributes
Name ID Value ID

Input	Filter 01 20	Hz 07

2	kHz 05



No	Commands



FP-AI-V10B
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID
±10	V 03



Attributes
Name ID Value ID

Input	Filter 01 20	Hz 07

2	kHz 05



No	Commands



FP-AI-V50m
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID
050	mV 19



Attributes
Name ID Value ID

Input	Filter 01 20	Hz 07

500	Hz 02



No	Commands



FP-AI-V100m
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Out	of	range 02



Ranges
Name ID

0100	mV 1A



Attributes
Name ID Value ID

Input	Filter 01 1	kHz 08

20	Hz 07



No	Commands



[c]FP-AO-200
All	ID	values	are	hexadecimal.



Module	ID
0102



Channel	Status
Message ID

Open	current	loop 01



Ranges
Name ID

021	mA 00

3.521	mA 01



No	Attributes

No	Commands



[c]FP-AO-210
All	ID	values	are	hexadecimal.



Module	ID
010F



Channel	Status
Message ID

Overcurrent	protection 01



Ranges
Name ID
010.2	V 04



No	Attributes

No	Commands



FP-AO-C020
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
020	mA 00



No	Attributes

No	Commands



FP-AO-C024
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID

0–24	mA 00



No	Attributes

No	Commands



FP-AO-C420
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
420	mA 01



No	Attributes

No	Commands



FP-AO-V5
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
05	V 06



No	Attributes

No	Commands



FP-AO-V5B
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
±5	V 05



No	Attributes

No	Commands



FP-AO-V10
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
010	V 04



No	Attributes

No	Commands



FP-AO-V10B
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
±10	V 03



No	Attributes

No	Commands



[c]FP-CTR-500
All	ID	values	are	hexadecimal.



Module	ID
010D



Channel	Status
Message ID

Overflow	since	last	read 01



Ranges
Name ID

Boolean 10

065535	Counts 40



Attributes
Name ID Value ID

Terminal	Count 05 065535
Terminal	Count	MSB
[Most	Significant	Byte]

06

Count	Source 07 External	Count	Input 00

Previous	Channel 01

1	kHz	Reference 02

32	kHz	Reference 03

Gate	Source 08 Gate	Input	0 00

Gate	Input	1 01

Gate	Input	2 02

Gate	Input	3 03

Always	Disabled 04

Always	Enabled 05

Read	Reset	Mode 09 Dont	Reset	On	Read 00

Reset	On	Read 01

Noise	Rejection 01 200	Hz 03

50	kHz 04

Output	Source 0A Counter	Channel	0 00

Counter	Channel	1 01

Counter	Channel	2 02

Counter	Channel	3 03

Counter	Channel	4 04

Counter	Channel	5 05

Counter	Channel	6 06

Counter	Channel	7 07

Discrete	Data 08

Output	Mode 0B Toggle,	Reset	Off 00

Toggle,	Reset	On 01

On	Pulse 02

Off	Pulse 03



Commands
Name ID Action ID

Control 01 Increment 02

Reset 01



[c]FP-CTR-502
All	ID	values	are	hexadecimal.



Module	ID
0114



Channel	Status
Message ID

Overflow	since	last	read 01



Ranges
Name ID

Boolean 10

065535	Counts 40



Attributes
Name ID Value ID

Terminal	Count 05 065535
Terminal	Count	MSB
[Most	Significant	Byte]

06

Count	Source 07 External	Count	Input 00

Previous	Channel 01

1	kHz	Reference 02

32	kHz	Reference 03

Gate	Source 08 Gate	Input	0 00

Gate	Input	1 01

Gate	Input	2 02

Gate	Input	3 03

Always	Disabled 04

Always	Enabled 05

Read	Reset	Mode 09 Dont	Reset	On	Read 00

Reset	On	Read 01

Noise	Rejection 01 200	Hz 03

50	kHz 04

Output	Source 0A Counter	Channel	0 00

Counter	Channel	1 01

Counter	Channel	2 02

Counter	Channel	3 03

Counter	Channel	4 04

Counter	Channel	5 05

Counter	Channel	6 06

Counter	Channel	7 07

Discrete	Data 08

Output	Mode 0B Toggle,	Reset	Off 00

Toggle,	Reset	On 01

On	Pulse 02

Off	Pulse 03



Commands
Name ID Action ID

Control 01 Increment 02

Reset 01



[c]FP-DI-300
All	ID	values	are	hexadecimal.



Module	ID
0109



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-DI-301
All	ID	values	are	hexadecimal.



Module	ID
0105



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



cFP-DI-304
All	ID	values	are	hexadecimal.



Module	ID
0129



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-DI-330
All	ID	values	are	hexadecimal.



Module	ID
0103



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



FP-DI-AC120
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



FP-DI-AC240
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



FP-DI-DC
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-DIO-550
All	ID	values	are	hexadecimal.



Module	ID
0126



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-DO-400
All	ID	values	are	hexadecimal.



Module	ID
0104



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-DO-401
All	ID	values	are	hexadecimal.



Module	ID
0106



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-DO-403
All	ID	values	are	hexadecimal.



Module	ID
0111



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-DO-410
All	ID	values	are	hexadecimal.



Module	ID
0110



Channel	Status
Message ID

Current	limited 07



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



FP-DO-AC120
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



FP-DO-AC240
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



FP-DO-DC60
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



FP-DO-DC200
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-PG-522
All	ID	values	are	hexadecimal.



Module	ID
0113



Ranges
Name ID

Boolean 10

065535	Counts 40



Attributes
Name ID Value ID

Pulse	Mode 0E Finite 00

Continuous 01

On	Time 0F 165535
On	Time	MSB
[Most	Significant	Byte]

10

Off	Time 11 065535
Off	Time	MSB 12

Resolution 13 100	µs 00

10	ms 01

1	s 02



Commands
Name ID Action ID

Control 01 Stop	After	Current	Pulse 04

Stop	Immediately 03

Generate	Pulses 02 165535
Generate	Pulses	MSB 03



[c]FP-PWM-520
All	ID	values	are	hexadecimal.



Module	ID
010E



Ranges
Name ID
0100% 38



Attributes
Name ID Value ID

Period	(ms) 0C 165535
Period	(ms)	MSB
[Most	Significant	Byte]

0D



No	Commands



[c]FP-QUAD-510
All	ID	values	are	hexadecimal.



Module	ID
0116



Ranges
Name ID

Boolean 10

065535 40

±160	count/µs 50

±80	count/µs 51

±40	count/µs 52

±20	count/µs 53

±10	count/µs 54

±5	count/µs 55

±2.5	count/µs 56

±1.25	count/µs 57



Attributes
Name ID Value ID

Reset	Mode 14 Dont	Reset	on	Index 00

Reset	on	Index 01



Commands
Name ID Action ID
Control 01 Reset 01



FP-RLY-420
All	ID	values	are	hexadecimal.



Module	ID
0108



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



cFP-RLY-421
All	ID	values	are	hexadecimal.



Module	ID
0121



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



FP-RLY-422
All	ID	values	are	hexadecimal.



Module	ID
0112



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



cFP-RLY-423
All	ID	values	are	hexadecimal.



Module	ID
0122



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



cFP-RLY-425
All	ID	values	are	hexadecimal.



Module	ID
0125



Ranges
Name ID
Boolean 10



No	Attributes

No	Commands



[c]FP-RTD-122
All	ID	values	are	hexadecimal.



Module	ID
010B



Channel	Status
Message ID

Out	of	range 01

Open	RTD 02



Ranges
Name ID

731123	K 26

200	to	850	°C 27

328	to	1562	°F 28

0400	Ω 30

04000	Ω 31



Attributes
Name ID Value ID

RTD	Type	(R0	and	TCR) 04 Pt100,	TCR=0.00375 00

Pt100,	TCR=0.00385 01

Pt100,	TCR=0.003911 02

Pt100,	TCR=0.003916 03

Pt100,	TCR=0.003920 04

Pt100,	TCR=0.003928 05

Pt1000,	TCR=0.00375 06

Pt1000,	TCR=0.00385 07

Pt1000,	TCR=0.003911 08

Pt1000,	TCR=0.003916 09

Pt1000,	TCR=0.003920 0A

Pt1000,	TCR=0.003928 0B



No	Commands



[c]FP-RTD-124
All	ID	values	are	hexadecimal.



Module	ID
0118



Channel	Status
Message ID

Out	of	range 01

Open	RTD 02



Ranges
Name ID

731123	K 26

200	to	850	°C 27

328	to	1562	°F 28

0400	Ω 30



Attributes
Name ID Value ID

RTD	Type	(R0	and	TCR) 04 Pt100,	TCR=0.00375 00

Pt100,	TCR=0.00385 01

Pt100,	TCR=0.003911 02

Pt100,	TCR=0.003916 03

Pt100,	TCR=0.003920 04

Pt100,	TCR=0.003928 05



No	Commands



FP-RTD-PT100-3
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01

Open	RTD 02



Ranges
Name ID

50	to	350	°C 2F

58	to	622	°F 32



No	Attributes

No	Commands



FP-RTD-PT100-4
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01

Open	RTD 02



Ranges
Name ID

50	to	350	°C 2F

58	to	622	°F 32



No	Attributes

No	Commands



FP-RTD-PT100
All	ID	values	are	hexadecimal.



Channel	Status
Message ID
Empty 01

Open	RTD 02



Ranges
Name ID

50	to	350	°C 2F

58	to	622	°F 32



No	Attributes

No	Commands



[c]FP-SG-140
All	ID	values	are	hexadecimal.



Module	ID
0119



Channel	Status
Message ID

Out	of	range 01

Overcurrent	protection 02



Ranges
Name ID

±3.90625	mV/V 64

±7.8125	mV/V 65

±31.25	mV/V 66

±62.5	mV/V 67



Attributes
Name ID Value ID

Noise	Rejection 01 15	Hz 09

60	Hz 00

240	Hz 0A

Excitation	Voltage 15 10	V 00

5	V 01

2.5	V 02

Half-Bridge	Completion 16 Half-Bridge	Completion	OFF 00

Half-Bridge	Completion	ON 01



No	Commands



FP-TB-10
All	ID	values	are	hexadecimal.



Module	ID
0217



Ranges,	Attributes,	and	Commands
Refer	to	the	module	reference	pages	for	the	dual-channel	modules	you
are	using.



[c]FP-TC-120
All	ID	values	are	hexadecimal.



Module	ID
0107



Channel	Status
Message ID

Out	of	range 01

Open	thermocouple 02



Ranges
Name ID

±50	mV 0A

±25	mV 0B

20	to	80	mV 0C

±100	mV 0D

02048	K 20

270	to	1770	°C 21

454	to	3218	°F 22



Attributes
Attribute	Name Attribute	ID Attribute	Value Attribute	ID

Thermocouple	Type 02 J 00

K 01

T 02

E 03

R 04

S 05

N 06

B 07

CJC	Source 03 Internal 00

0	°C 01

25	°C 02



No	Commands



FP-TC-J
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Open	thermocouple 02



Ranges
Name ID

210	to	1200	°C 29

346	to	2191	°F 2A



No	Attributes

No	Commands



FP-TC-K
All	ID	values	are	hexadecimal.



Channel	Status
Message ID

Empty 01

Open	thermocouple 02



Ranges
Name ID

100	to	1372	°C 2B

148	to	2501	°F 2C



No	Attributes

No	Commands



Glossary
Prefixes 	 A 	 B 	 C 	 D 	 H 	 I 	 L 	 N 	 O 	 P 	 R 	 S 	 V

Symbol Prefix Value

m milli 10-3

k kilo 103

M mega 106

A

advise
rate

The	rate	at	which	advise	operations	are	performed	on	a	FieldPoint
item.	If	the	advise	rate	of	the	item	is	different	from	the	screen	update
rate	of	the	window	where	you	are	monitoring	the	item,	you	may	not
see	the	advises	as	they	occur.	Adjust	either	the	advise	rate	of	the	item
or	the	screen	update	rate	of	the	window.

analog
channel

A	channel	on	a	FieldPoint	module	that	accesses	data	represented	as
continuously	variable	quantities.	For	example,	an	analog	channel
could	monitor	a	temperature	sensor.

API Application	programming	interface.

B

B Bytes.

bank A	FieldPoint	network	module	and	all	the	FieldPoint	modules
connected	to	it.

C

comm
resource

Communication	resource.	A	pathway	through	which	MAX
communicates	with	FieldPoint	devices.	A	comm	resource	can	be	a
serial	port	or	an	IP	address.

controller A	FieldPoint	network	module	that	can	run	embedded	LabVIEWapplications.



D

default
items

Items	that	MAX	creates	automatically	in	My	System»Data
Neighborhood	when	it	finds	a	specific	type	of	device.	For	example,	if
MAX	detects	an	FP-AO-200	module,	it	creates	one	item	for	each
output	channel	and	one	item	representing	all	eight	output	channels.

device A	FieldPoint	module.
discrete
channel

A	channel	that	can	have	one	of	two	values:	On	or	Off.	For	example,	a
switch	is	a	discrete	channel.

.dll Dynamic	link	library.	An	executable	that	can	be	loaded	at	runtime.
duplicate
count

The	number	of	duplicate	elements	to	add	to	the	current	.iak
configuration	file.

H

hotswap To	add	or	remove	an	I/O	module	from	a	FieldPoint	bank	while	the
power	is	on	and	the	bank	is	functioning.

I

I/O
module A	FieldPoint	module	with	channels	for	input	and/or	output.

I/O	point A	site	for	input	and/or	output	of	data.	Also	called	a	channel	or	item.
.iak File	extension	for	a	FieldPoint	configuration	file.

item

One	or	more	channels	or	variables	in	a	FieldPoint	bank	that	can	be
monitored	or	controlled	by	MAX.	In	MAX,	items	are	normally	I/O
points.	A	blue	icon	indicates	that	the	item	is	being	monitored.	A	gray
icon	indicates	that	the	item	is	not	being	monitored.

L

LabVIEW
item

When	a	Publish	Data	vi	runs	on	a	[c]FP-2xxx	controller,	it	creates	a
LabVIEW	data	item	in	the	Data	Neighborhood	of	the	controller.

N

The	network	module	sends	and	receives	commands	and	data	between



network
module

the	computer	and	the	I/O	modules	in	a	FieldPoint	bank.	Ethernet
network	modules	include	RT	controllers	such	as	the	[c]FP-2xxx	and
non-RT	network	modules	such	as	the	FP-1601	and	cFP-180x.

O

OPC OLE	for	Process	Control.	An	I/O	specification.	Refer	to	the	OPC
Foundation	Web	site,	www.opcfoundation.org,	for	more	information.

P

password
To	set	a	password	for	a	FieldPoint	Ethernet	controller,	click	the	Lock
button	on	the	Network	Settings	tab	and	enter	the	password	when
prompted.

R

remote
I/O

Using	a	FieldPoint	RT	controller	to	access	I/O	modules	connected	to
other	network	modules.	Refer	to	the	Remote	I/O	topic	of	the
FieldPoint	LabVIEW	Interface	Help	for	more	information	about
remote	I/O.

S

s Seconds.

screen
update
rate

The	rate	at	which	the	value	column	of	the	I/O	Data	tab	updates.	If	the
advise	rate	of	the	item	is	different	from	the	screen	update	rate,	you
may	not	see	the	advises	as	they	occur.	Adjust	either	the	advise	rate	of
the	item	or	the	screen	update	rate	of	the	I/O	Data	tab.

status The	status	of	the	last	read	or	write	operation	to	the	selected
FieldPoint	item.

V

value The	numeric	value	to	write	to	the	selected	FieldPoint	item.
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Warranty
The	media	on	which	you	receive	National	Instruments	software	are	warranted
not	to	fail	to	execute	programming	instructions,	due	to	defects	in	materials	and
workmanship,	for	a	period	of	90	days	from	date	of	shipment,	as	evidenced	by
receipts	or	other	documentation.	National	Instruments	will,	at	its	option,	repair
or	replace	software	media	that	do	not	execute	programming	instructions	if
National	Instruments	receives	notice	of	such	defects	during	the	warranty	period.
National	Instruments	does	not	warrant	that	the	operation	of	the	software	shall	be
uninterrupted	or	error	free.
A	Return	Material	Authorization	(RMA)	number	must	be	obtained	from	the
factory	and	clearly	marked	on	the	outside	of	the	package	before	any	equipment
will	be	accepted	for	warranty	work.	National	Instruments	will	pay	the	shipping
costs	of	returning	to	the	owner	parts	which	are	covered	by	warranty.
National	Instruments	believes	that	the	information	in	this	document	is	accurate.
The	document	has	been	carefully	reviewed	for	technical	accuracy.	In	the	event
that	technical	or	typographical	errors	exist,	National	Instruments	reserves	the
right	to	make	changes	to	subsequent	editions	of	this	document	without	prior
notice	to	holders	of	this	edition.	The	reader	should	consult	National	Instruments
if	errors	are	suspected.	In	no	event	shall	National	Instruments	be	liable	for	any
damages	arising	out	of	or	related	to	this	document	or	the	information	contained
in	it.
EXCEPT	AS	SPECIFIED	HEREIN,	NATIONAL	INSTRUMENTS	MAKES
NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AND	SPECIFICALLY
DISCLAIMS	ANY	WARRANTY	OF	MERCHANTABILITY	OR	FITNESS
FOR	A	PARTICULAR	PURPOSE.	CUSTOMER'S	RIGHT	TO	RECOVER
DAMAGES	CAUSED	BY	FAULT	OR	NEGLIGENCE	ON	THE	PART	OF
NATIONAL	INSTRUMENTS	SHALL	BE	LIMITED	TO	THE	AMOUNT
THERETOFORE	PAID	BY	THE	CUSTOMER.	NATIONAL	INSTRUMENTS
WILL	NOT	BE	LIABLE	FOR	DAMAGES	RESULTING	FROM	LOSS	OF
DATA,	PROFITS,	USE	OF	PRODUCTS,	OR	INCIDENTAL	OR
CONSEQUENTIAL	DAMAGES,	EVEN	IF	ADVISED	OF	THE	POSSIBILITY
THEREOF.	This	limitation	of	the	liability	of	National	Instruments	will	apply
regardless	of	the	form	of	action,	whether	in	contract	or	tort,	including
negligence.	Any	action	against	National	Instruments	must	be	brought	within	one
year	after	the	cause	of	action	accrues.	National	Instruments	shall	not	be	liable	for



any	delay	in	performance	due	to	causes	beyond	its	reasonable	control.	The
warranty	provided	herein	does	not	cover	damages,	defects,	malfunctions,	or
service	failures	caused	by	owner's	failure	to	follow	the	National	Instruments
installation,	operation,	or	maintenance	instructions;	owner's	modification	of	the
product;	owner's	abuse,	misuse,	or	negligent	acts;	and	power	failure	or	surges,
fire,	flood,	accident,	actions	of	third	parties,	or	other	events	outside	reasonable
control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or	transmitted
in	any	form,	electronic	or	mechanical,	including	photocopying,	recording,
storing	in	an	information	retrieval	system,	or	translating,	in	whole	or	in	part,
without	the	prior	written	consent	of	National	Instruments	Corporation.



Patents
For	patents	covering	National	Instruments	products,	refer	to	the	appropriate
location:	Help»Patents	in	your	software,	the	patents.txt	file	on	your	CD,	or
ni.com/patents.

javascript:WWW(WWW_Patents)


Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks	of	National
Instruments	Corporation.	Refer	to	the	Terms	of	Use	section	on	ni.com/legal	for
more	information	about	National	Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,	Simulink®,	and
Stateflow®	are	registered	trademarks,	and	TargetBox2™,	xPC	TargetBox2™,
and	Target	Language	Compiler™	are	trademarks	of	The	MathWorks,	Inc.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
Other	product	and	company	names	mentioned	herein	are	trademarks	or	trade
names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program	are	business
entities	independent	from	National	Instruments	and	have	no	agency,	partnership,
or	joint-venture	relationship	with	National	Instruments.

javascript:WWW(WWW_Trademark)


WARNING	REGARDING	USE	OF	NATIONAL
INSTRUMENTS	PRODUCTS
(1)	NATIONAL	INSTRUMENTS	PRODUCTS	ARE	NOT	DESIGNED	WITH
COMPONENTS	AND	TESTING	FOR	A	LEVEL	OF	RELIABILITY
SUITABLE	FOR	USE	IN	OR	IN	CONNECTION	WITH	SURGICAL
IMPLANTS	OR	AS	CRITICAL	COMPONENTS	IN	ANY	LIFE	SUPPORT
SYSTEMS	WHOSE	FAILURE	TO	PERFORM	CAN	REASONABLY	BE
EXPECTED	TO	CAUSE	SIGNIFICANT	INJURY	TO	A	HUMAN.
(2)	IN	ANY	APPLICATION,	INCLUDING	THE	ABOVE,	RELIABILITY	OF
OPERATION	OF	THE	SOFTWARE	PRODUCTS	CAN	BE	IMPAIRED	BY
ADVERSE	FACTORS,	INCLUDING	BUT	NOT	LIMITED	TO
FLUCTUATIONS	IN	ELECTRICAL	POWER	SUPPLY,	COMPUTER
HARDWARE	MALFUNCTIONS,	COMPUTER	OPERATING	SYSTEM
SOFTWARE	FITNESS,	FITNESS	OF	COMPILERS	AND	DEVELOPMENT
SOFTWARE	USED	TO	DEVELOP	AN	APPLICATION,	INSTALLATION
ERRORS,	SOFTWARE	AND	HARDWARE	COMPATIBILITY	PROBLEMS,
MALFUNCTIONS	OR	FAILURES	OF	ELECTRONIC	MONITORING	OR
CONTROL	DEVICES,	TRANSIENT	FAILURES	OF	ELECTRONIC
SYSTEMS	(HARDWARE	AND/OR	SOFTWARE),	UNANTICIPATED	USES
OR	MISUSES,	OR	ERRORS	ON	THE	PART	OF	THE	USER	OR
APPLICATIONS	DESIGNER	(ADVERSE	FACTORS	SUCH	AS	THESE	ARE
HEREAFTER	COLLECTIVELY	TERMED	"SYSTEM	FAILURES").	ANY
APPLICATION	WHERE	A	SYSTEM	FAILURE	WOULD	CREATE	A	RISK
OF	HARM	TO	PROPERTY	OR	PERSONS	(INCLUDING	THE	RISK	OF
BODILY	INJURY	AND	DEATH)	SHOULD	NOT	BE	RELIANT	SOLELY
UPON	ONE	FORM	OF	ELECTRONIC	SYSTEM	DUE	TO	THE	RISK	OF
SYSTEM	FAILURE.	TO	AVOID	DAMAGE,	INJURY,	OR	DEATH,	THE
USER	OR	APPLICATION	DESIGNER	MUST	TAKE	REASONABLY
PRUDENT	STEPS	TO	PROTECT	AGAINST	SYSTEM	FAILURES,
INCLUDING	BUT	NOT	LIMITED	TO	BACK-UP	OR	SHUT	DOWN
MECHANISMS.	BECAUSE	EACH	END-USER	SYSTEM	IS	CUSTOMIZED
AND	DIFFERS	FROM	NATIONAL	INSTRUMENTS'	TESTING
PLATFORMS	AND	BECAUSE	A	USER	OR	APPLICATION	DESIGNER
MAY	USE	NATIONAL	INSTRUMENTS	PRODUCTS	IN	COMBINATION
WITH	OTHER	PRODUCTS	IN	A	MANNER	NOT	EVALUATED	OR
CONTEMPLATED	BY	NATIONAL	INSTRUMENTS,	THE	USER	OR



APPLICATION	DESIGNER	IS	ULTIMATELY	RESPONSIBLE	FOR
VERIFYING	AND	VALIDATING	THE	SUITABILITY	OF	NATIONAL
INSTRUMENTS	PRODUCTS	WHENEVER	NATIONAL	INSTRUMENTS
PRODUCTS	ARE	INCORPORATED	IN	A	SYSTEM	OR	APPLICATION,
INCLUDING,	WITHOUT	LIMITATION,	THE	APPROPRIATE	DESIGN,
PROCESS	AND	SAFETY	LEVEL	OF	SUCH	SYSTEM	OR	APPLICATION.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	National	Instruments	Web	site	at	ni.com	for
technical	support	and	professional	services:

Support—Online	technical	support	resources	at	ni.com/support	include
the	following:

Self-Help	Resources—For	answers	and	solutions,	visit	the	award-
winning	National	Instruments	Web	site	for	software	drivers	and
updates,	a	searchable	KnowledgeBase,	product	manuals,	step-by-
step	troubleshooting	wizards,	thousands	of	example	programs,
tutorials,	application	notes,	instrument	drivers,	and	so	on.
Free	Technical	Support—All	registered	users	receive	free	Basic
Service,	which	includes	access	to	hundreds	of	Applications
Engineers	worldwide	in	the	NI	Developer	Exchange	at
ni.com/exchange.	National	Instruments	Applications	Engineers
make	sure	every	question	receives	an	answer.
For	information	about	other	technical	support	options	in	your	area,
visit	ni.com/services	or	contact	your	local	office	at	ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-paced	training,
eLearning	virtual	classrooms,	interactive	CDs,	and	Certification	program
information.	You	also	can	register	for	instructor-led,	hands-on	courses	at
locations	around	the	world.
System	Integration—If	you	have	time	constraints,	limited	in-house
technical	resources,	or	other	project	challenges,	National	Instruments
Alliance	Partner	members	can	help.	To	learn	more,	call	your	local	NI
office	or	visit	ni.com/alliance.

If	you	searched	ni.com	and	could	not	find	the	answers	you	need,	contact	your
local	office	or	NI	corporate	headquarters.	You	also	can	visit	the	Worldwide
Offices	section	of	ni.com/niglobal	to	access	the	branch	office	Web	sites,	which
provide	up-to-date	contact	information,	support	phone	numbers,	email	addresses,
and	current	events.

javascript:WWW(WWW_Support)
javascript:WWW(WWW_KB)
javascript:WWW(WWW_Manuals)
javascript:WWW(WWW_Exchange)
javascript:WWW(WWW_Service)
javascript:WWW(WWW_Contact)
javascript:WWW(WWW_Customer_Education)
javascript:WWW(WWW_Integration)
javascript:WWW(WWW_Global)


Time	Server
A	time	server	ensures	that	all	FieldPoint	banks	on	the	network	are
synchronized.	Any	computer	running	FieldPoint	software	and	connected	to	the
network	can	be	a	time	server.	A	time	client	synchronizes	with	a	time	server
periodically.	Any	FieldPoint	Ethernet	network	module	can	be	a	time	client.	A
[c]FP-2xxx	running	LabVIEW	RT	7.1	or	later	can	be	a	time	client,	a	time	server,
or	both.
To	configure	a	FieldPoint	Ethernet	network	module	as	a	time	client,	go	to	the
Network	Settings	tab	and	enter	the	IP	address	of	the	time	server	in	the	Time
Server	box,	then	click	Apply.
To	configure	a	[c]FP-2xxx	as	a	time	server,	go	to	the	Bank	Configuration	tab
and	check	the	Enable	as	Time	Server	box,	then	click	Apply.	If	you	do	not	want
the	[c]FP-2xxx	to	synchronize	with	an	external	time	server,	go	to	the	Network
Settings	tab	and	enter	0.0.0.0	in	the	Time	Server	field,	then	click	Apply.
To	configure	a	[c]FP-2xxx	as	both	a	time	server	and	a	time	client,	go	to	the	Bank
Configuration	tab	and	check	the	Enable	as	Time	Server	box,	then	click	Apply.
Go	to	the	Network	Settings	tab	and	enter	the	IP	address	of	the	time	server	in	the
Time	Server	field,	then	click	Apply.
The	[c]FP-2xxx	has	an	internal	clock	that	provides	consistent	timestamps	in	the
absence	of	a	time	server.	You	can	set	the	date	and	time	on	the	[c]FP-2xxx	using
the	RT	Set	Date	and	Time	VI.	For	information	about	using	this	VI,	refer	to	the
LabVIEW	Help.
Back	to	Configuring	an	Ethernet	Network	Module



Branch	Offices
Office Telephone	Number

Australia 1800	300	800

Austria 43	0	662	45	79	90	0

Belgium 32	0	2	757	00	20

Brazil 55	11	3262	3599

Canada 800	433	3488

China 86	21	6555	7838

Czech	Republic 420	224	235	774

Denmark 45	45	76	26	00

Finland 385	0	9	725	725	11

France 33	0	1	48	14	24	24

Germany 49	0	89	741	31	30

India 91	80	51190000

Israel 972	0	3	6393737

Italy 39	02	413091

Japan 81	3	5472	2970

Korea 82	02	3451	3400

Lebanon 961	0	1	33	28	28

Malaysia 1800	887710

Mexico 01	800	010	0793

Netherlands 31	0	348	433	466

New	Zealand 0800	553	322

Norway 47	0	66	90	76	60

Poland 48	22	3390150

Portugal 351	210	311	210

Russia 7	095	783	68	51

Singapore 1800	226	5886

Slovenia 386	3	425	4200

South	Africa 27	0	11	805	8197

Spain 34	91	640	0085

Sweden 46	0	8	587	895	00

Switzerland 41	56	200	51	51

Taiwan 886	02	2377	2222

Thailand 662	278	6777

United	Kingdom 44	0	1635	523545

United	States	(Corporate) 512	683	0100


